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Preface

Welcome to the Simplify Suite Administrator Guide. The purpose of the Simplify Suite 
Administrator Guide is to answer your questions and guide you through the procedures that 
are available through the Simplify Console for administering and maintaining the Simplify 
Suite efficiently and effectively.

Using the manual
You will find the Simplify Suite Administrator Guide easy to use. You can simply look up the 
topic that you need in the Table of Contents. Later, in this Preface, you will find a brief 
discussion of each chapter to further assist you in locating the information that you need.

Special information about the manual
The Simplify Suite Administrator Guide has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you view the document online, a standard set of bookmarks appears in 
a frame on the left side of the document window for navigation through the document.

Conventions used in the manual
The Simplify Suite Administrator Guide uses the following conventions:

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <server address>. Do 
not type the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover, and ending on the last page of the guide.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents entries are also 
hyperlinks. Click the hyperlink to advance to the referenced information.

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the Table of Contents.
Simplify Suite Administrator Guide 8
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Assumptions for the manual
The Simplify Suite Administrator Guide assumes that:

• You are familiar with Windows-based applications and basic Windows functions and 
navigational elements.

• References to any third-party standards or third-party software functions were current as 
of the release of this version of Simplify Suite, and might have already changed. 

Organization of the manual
In addition to this Preface, the Simplify Suite Administrator Guide contains the following 
sections, chapters, and appendices:

• Section 1, “Simplify Console,” on page 11 provides detailed instructions for administering 
and managing Simplify Suite with Simplify Console. This section contains the following 
chapters:

• Chapter 1, “Getting Started with Simplify Console,” on page 12 an overview of 
Simplify Console as well as the major navigational elements for the console. It also 
details how to customize the Simplify Console layout and how to modify its default 
values to better suit your working needs.

• Chapter 2, “The Simplify Console Panes,” on page 27 details the structure and 
available functions for the Owners pane, the Assignments pane, and the Objects 
pane, which are the three primary panes in the Simplify Console window in which you 
carry out your administration and maintenance tasks.

• Chapter 3, “Managing the Simplify Suite with Simplify Console,” on page 38 details 
all the functions that are available in Simplify Console for administering and 
maintaining the needed owners, objects, and assignments for your Simplify Suite 
installations.

• Chapter 4, “Data Review in the Simplify Console,” on page 60 details the two primary 
functions that are available in Simplify Console for reviewing and analyzing the data 
in your Simplify database – audits and reports.

• Chapter 5, “Simplify Console Tools,” on page 68 details the tools that available 
through Simplify Console for retrieving and manipulating the data that is relevant to 
the operation of Simplify Suite, and for configuring the console and/or Simplify Suite.

• Section 2, “Simplify Printing,” on page 72 provides detailed instructions for administering 
and managing Simplify Printing. This section contains the following chapters and 
appendices:

• Chapter 1, “Getting Started with Simplify Printing,” on page 73 provides information 
about logging in to Simplify Console for managing your Simplify Printing instance. It 
also provides a high-level overview of the ways that different clients can interact with 
Simplify Printing.

• Chapter 2, “Managing Printer Objects in Simplify Printing,” on page 78 details how to 
Simplify Suite Administrator Guide 9
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add, assign, and configure the necessary print server printers for your users in the 
Simplify Printing environment. 

• Chapter 3, “Managing ScrewDrivers Objects and Settings,” on page 100 details the 
ScrewDrivers configuration settings that are available for assignment in the Simplify 
Console.

• Appendix A, “ScrewDrivers Troubleshooting,” on page 110 provides somes general 
considerations when troubleshooting the ScrewDrivers components of Simplify 
Printing. It also provides information about solving some of the most common 
problems you might encounter when using ScrewDrivers.
Simplify Suite Administrator Guide 10
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Section 1
Simplify Console

Section Contents
• Getting Started with Simplify Console on page 12

• The Simplify Console Panes on page 27

• Managing the Simplify Suite with Simplify Console on page 38

• Data Review in the Simplify Console on page 60

• Simplify Console Tools on page 68



Chapter 1
Getting Started with Simplify 
Console

Tricerat’s Simplify Suite is a complete user management tool that incorporates a software 
framework to extend and enhance Windows server operating systems, which boosts 
Microsoft RDS performance, Citrix XenApp reliability and security, as well as supporting 
VMware virtual desktop infrastructure (VDI) and Windows workstations. Simplify Console is 
the management interface for all the Simplify Suite components. This chapter provides an 
overview of Simplify Console as well as the major navigational elements for the console. It 
also details how to customize the Simplify Console layout and how to modify its default 
values to better suit your working needs.

This chapter covers the following topics:

• “Simplify Console Overview” on page 13.

• “The Simplify Console Layout” on page 15.

• “Customizing the Simplify Console Layout” on page 19.

• “Specifying Simplify Suite Options” on page 25.
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Simplify Console Overview
Simplify Console is the management feature of Simplify Suite. You manage the entire 
Simplify Suite application through Simplify Console. By default, Simplify Console is installed 
on the same Windows clients on which you are installing Simplify Suite. If you do not install 
Simplify Console for at least one instance of Simplify Suite, then you are not able to manage 
or configure any of your Simplify Suite components. Because Simplify Console is 
unlicensed, you can also install it as a standalone application to as many workstations as 
needed. (Many Simplify Suite administrators install Simplify Console on their workstations to 
provide a way to assign objects and change settings remotely.) 

After Simplify Console has been installed, a shortcut icon for the application is placed on 
your desktop. An option for Simplify Console is also available from your Start menu. You can 
double-click the desktop icon to launch Simplify Console, or you can select the option from 
your Start menu (Start > All Programs > Tricerat > Simplify Console).

Figure 1-1:  Simplify Console desktop shortcut

The first time that you start Simplify Console, a message opens asking which products that 
you want to display in the console: Simplify Printing, Simplify Desktop, Simplify Lockdown, 
and/or Simplify Profiles. By default, all products are selected for display. Clear a selection to 
remove the product from the Simplify Console display. After you make your selections, and 
then click OK, Simplify Console opens.

Figure 1-2:  Products to display message

For detailed instructions about installing Simplify Console as a standalone 
application, see the Simplify Suite Installation Guide.
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When you start Simplify Console, it establishes and maintains a connection with the SQL 
Server ODBC data source that was configured prior to installation. This data source is used 
to store all persistent data that is related to the operation of Simplify Suite. If Active Directory 
is in use, then the Simplify Console queries Active Directory to produce a hierarchical list of 
owners, which are entities that can receive assignments of objects and/or configuration 
settings such as shell preference in the Simplify Suite environment. 

Figure 1-3:  Simplify Console window

You can always change the products that are or are not displayed in the Simplify 
Console. See “Specifying Simplify Suite Options” on page 25. Simplify Stability is 
a legacy product. For assistance with this product, contact Tricerat.
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The Simplify Console Layout
The Simplify Console user interface consists of a single window that has four major 
components – the title bar, the main menu, the toolbar, and the panes. See:

• “Title bar” below.

• “Main menu” below.

• “Toolbar” below.

• “Panes” on page 17.

Title bar
“Tricerat Simplify Console” and the version number for the currently installed version are 
displayed in the title bar at the top of the Simplify Suite window. The title bar also displays the 
Data Source Name (DSN) for the Simplify database.

Figure 1-4:  Simplify Console title bar

Main menu
By default, the Simplify Console main menu is docked beneath the title bar. The menu is set 
up in a standard Windows format with menu commands grouped into menus (File, Edit, 
View, Tools, Report, and Help) across the menu bar. Some of these commands are available 
in other areas of the console. You can dock the main menu in a different location, or you can 
float it, which means that it is not confined to a specific location. See “Customizing the 
Simplify Console Layout” on page 19.

Figure 1-5:  Simplify Console main menu

Toolbar
By default, the Simplify Console toolbar is docked beneath the main menu. The toolbar 
provides quick access to all the Simplify Console functions. The toolbar is divided into four 
separate tear-off palettes: File, Edit, View, and Tools. You can click the Tear Off icon for a 
palette (the three vertical dots in a row at the far left of the pallet), and then drag the palette 
to a new location. When you tear off a toolbar palette, you can dock the palette in a different 
location, or you can float it, which means that it is not confined to a specific location. (See 
“Customizing the Simplify Console Layout” on page 19.) You can also hold your mouse 
pointer over an icon on the toolbar to open a tooltip that describes the icon’s function or 

To see the version number for each component that has been installed for Simplify 
Suite, on the main menu, click Help > About Simplify Console.
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purpose. See Figure 1-6 and Table 1-1 below.

Figure 1-6:  Simplify Console toolbar

Table 1-1: Simplify Console toolbar icons 

Icon Description
Manage Database icon – Opens the Manage Data Sources dialog box, which 
contains all the functions and options for managing the data sources to which the 
Simplify Suite connects. See “The Manage Data Sources Tool” on page 71.

Refresh Database icon – Refreshes the Simplify database.
Note: This option is also available from the Simplify Console main menu under 

File > Refresh Database.

Undo icon – Enabled only when entering data in a free text field on an Object 
form. Click this icon to delete any text that you have entered and clear the field or 
reset the field to its default value. 

Cut icon – Removes a selected entity from its physical location, and stores it in a 
buffer for pasting in another location.
Note: Applicable only for free text fields on an Object form.

Copy icon – Copies a selected entity to the client clipboard in preparation for 
pasting it in to another location.
Note: Applicable only for free text fields on an Object form.

N/A.

Show Owners icon – If not already opened, then opens the Owners pane. See 
“The Owners Pane” on page 28.
Note: This option is also available on the View menu (View > Owners).

Show Assignments icon – If not already opened, then opens the Assignments 
pane. See “The Assignments Pane” on page 32.
Note: This option is also available on the View menu (View > Assignments).

Show Objects icon – If not already opened, then opens the Objects pane. See 
“The Objects Pane” on page 35.
Note: This option is also available on the View menu (View > Objects).

Show triReg icon – If not already opened, then opens the triReg pane, which is a 
tool that you use for viewing and managing Simplify Profiles. See “The triReg 
Tool” on page 193.
Note: This option is also available on the View menu (View > triReg).

Show Audit icon – If not already opened, then opens the Audit pane. See 
“Auditing the Simplify Database” on page 61.
Note: This option is also available on the View menu (View > Audit).

Options icon – Opens the Options dialog box. See “Specifying Simplify Suite 
Options” on page 25.
Note: This option is also available on the Tools menu (Tools > Options).
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Panes
The Simplify Console window has three primary panes in which you carry out the majority of 
activities that are needed to manage your Simplify Suite installation: the Owners pane, the 
Assignments pane, and the Objects pane. When the Simplify Console first opens, its single 
window opens in its default layout, which consists from left to right of the opened and docked 
Owners pane, Assignments pane, and Objects pane. The panes are docked in the 
workspace for the window. The triReg tool and the Audit tool are also open, but the pane 
interfaces for these tools are hidden. Instead, pane tabs are displayed. The triReg pane tab 
is docked at the upper left edge of the Simplify Console window, and the Audit tab pane is 
docked at the lower left edge of the window.

Figure 1-7:  Simplify Console window, default layout with docked panes

Any pane or pane group in the Simplify Console window can be in one of four states:

• Docked –The pane is visible in the Simplify Console window and its location is confined 
to a specific area of the workspace.

• Floating –The pane is visible in the Simplify Console window, but its location is not 
confined to a specific area of the workspace. Instead, you can independently change its 
size and/or position.

• Hidden –The pane is not visible in the Simplify Console window. Instead, a corresponding 
pane tab is displayed at an edge of the Simplify Console window.

• Closed – Neither the tab nor a corresponding tab pane is displayed in the Simplify 
Console window.

Item Description
1 Hidden triReg tool.

2 Hidden Audit tool.

1

2
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A variety of options are available for working with the panes to customize the layout of the 
Simplify Console window to better suit your working needs. See “Customizing the Simplify 
Console Layout” on page 19.
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Customizing the Simplify Console Layout
When Simplify Console first opens, its single window opens in its default layout, which from 
left to right consists of the following opened and docked panes: Owners, Assignments, and 
Objects. The panes are docked in the workspace for the window. The triReg tool and the 
Audit tool are also open, but the pane interfaces for these tools are hidden. Instead, pane 
tabs are displayed. The triReg pane tab is docked at the upper left edge of the Simplify 
Console window, and the Audit tab pane is docked at the lower left edge of the window. You 
can do any or all of the following to customize the layout:

• Move (dock or float) the main menu or the toolbar. See “To dock or float the main menu 
and/or toolbar palettes” below.

• Open/close a pane. See “To open or close a pane” below.

• Resize a pane. See “To resize a pane” on page 20.

• Auto hide a pane. See “To auto hide a pane” on page 21.

• Show an auto-hidden pane. See “To show an Auto Hidden pane” on page 22.

• Float a docked pane. See “To float a docked pane” on page 22.

• Create a pane group. See “To create a pane group” on page 23.

• Reset the Simplify Console to its default layout. See “To reset the Simplify Console to its 
default layout” on page 24.

To dock or float the main menu and/or toolbar palettes
When Simplify Console opens for the first time, by default, the main menu is docked in the 
top left corner of the window, and the toolbar is docked below the main menu. Both the main 
menu and toolbar are tear-off palettes, which means that you can click the Tear Off icon (the 
three vertical dots in a row at the far left of the pallet), and then drag the palette to a new 
location. When you drag the menu and/or toolbar, you can dock it on any of the four edges of 
the console window, or you can float it above the window.

To open or close a pane
You have two options for opening a pane in the Simplify Console:

• On the main menu, click File, and then click the appropriate menu item. For example, to 
open the Owners pane, on the main menu, click File > Owners. 

If you dock or float the main menu and/or the toolbar, then File > Reset Layout 
does not return these components to their default locations. Instead, you must 
close the Simplify Console, and then open it again. If you float a toolbar palette, 
and then close the palette. you can right-click anywhere on the toolbar, and on the 
context menu that opens. select the palette (File, Edit, View, and Tools) to open it 
again.
Simplify Suite Administrator Guide 19
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• On the Simplify Console toolbar, click the appropriate icon. See “Toolbar” on page 15.

To close a pane at any time, in the upper right corner of the pane, click the Close (x) icon.

To resize a pane
When a pane first opens in the Simplify Console, it is set to a default size. You can resize any 
pane as needed to better suit your working needs. To resize a pane in the Simplify Console, 
do the following:

1. Hold your mouse pointer on the edge of a pane, or on the border that separates two 
panes until the cursor changes to a bi-directional arrow.

2. Hold down the left mouse button, drag the edge or border until the pane is resized to 
your preference, and then release the left mouse button.

Figure 1-8:  Resizing a pane

To dock a pane
When the Simplify Console first opens, its single window opens in its default layout. You can 
move a window pane from its default location by docking it, which means to attach it to a 
different part of the Simplify Console window. To dock a pane in a different position in the 
Simplify Console window, do the following:

1. Click anywhere in the title bar of the pane, and then drag it until individual dim location 
icons are displayed on the left, right, top, and bottom of the workspace, or all four 
location icons are displayed as a target in the middle of the workspace.

Figure 1-9:  Docking a pane

2. Drop the pane onto the appropriate location icon. 
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To auto hide a pane
The Auto Hide feature minimizes a pane and provides a pane tab in its place for dynamically 
displaying the pane. The window pane is “pinned” as a tab to an edge of the Simplify 
Console window so that you have more room for your workspace. You can hold your mouse 
pointer over the pane tab to open and temporarily display the pane. You can then move your 
mouse pointer off the pane tab to minimize the pane again. If Auto Hide is applicable for a 
pane, then an Auto Hide icon (a pushpin icon) is displayed in the upper right corner of the 
pane. To auto hide a pane, click the Auto Hide icon. The location of the pane tab for an auto 
hidden pane in the Simplify Console is determined by the location of the open pane in the 
workspace before it was auto-hidden. For example, if you auto hide the Owners pane while 
the panes are displayed in their default layout, then the Owners tab pane is displayed in the 
upper left corner of the workspace. If you auto hide the Owners pane while it is displayed at 
the bottom of Simplify Console workspace, then the Owners pane tab is displayed at the 
bottom of the Simplify Console workspace.

Figure 1-10: Auto hiding a pane while in the Simplify Console default layout

Figure 1-11: Auto hiding a pane with any layout other than the default layout
Simplify Suite Administrator Guide 21



Chapter 1
Getting Started with Simplify Console
To show an Auto Hidden pane
The Auto Hide feature minimizes a pane and provides a pane tab in its place for dynamically 
displaying the pane. You can hold your mouse pointer over the pane tab to open and 
temporarily display the pane. The Auto Hide icon is displayed horizontally, indicating that the 
pane is currently auto-hidden. You can move your mouse pointer off the pane tab to auto 
hide the pane again, or you can click the Auto Hide icon to display the pane. If you show an 
auto-hidden pane, then it is docked in the position in which it was located before it was auto-
hidden. 

Figure 1-12: Showing an auto-hidden pane

To float a docked pane
A floating pane is a pane that is visible in the Simplify Console window, but its location is not 
confined to a specific area of the workspace. Instead, you can independently change its size 
and/or position. You can float any docked pane. To float a docked pane, double-click the 
pane title bar. The pane is immediately undocked and set to a default size and location in the 
workspace. You can click and hold your mouse pointer in the title bar of a floating pane to 
make it the active pane, and then drag to any location in the Simplify Console workspace. 
You can also resize the pane. (See “To resize a pane” on page 20.) If you double-click in the 
title bar of a floating pane again, then the pane is docked again in the position in which it was 
located before it was floated. See Figure 1-13 on page 23.
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Figure 1-13: Floating a docked pane

To create a pane group
You can combine two or more pane tabs to create a pane group. To create a pane group, 
click anywhere in the title bar of an open pane, and then drag the pane onto the title bar of 
another open pane. Both panes are collapsed into pane tabs. The pane that you dragged 
remains open. The other pane is closed. The series of tabs that represent the panes are 
titled accordingly, and they are displayed in a horizontal row below the pane group. To open 
and bring any pane into focus in a pane group, click the appropriate tab. All the actions that 
are applicable for a single pane (floating, docking, auto hiding, showing an auto-hidden pane 
group, resizing a pane, and closing) are also applicable for a pane group.

Figure 1-14: A pane group in the Simplify Console workspace
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To reset the Simplify Console to its default layout
If you make changes to the default layout of the Simplify Suite, then these changes are 
“remembered” even after exiting (File > Exit), and then opening Simplify Console again. To 
reset the display of the panes in Simplify Console to its default layout at any time, on the 
main menu, click View > Reset Layout.

If you have docked the main menu and/or toolbar in a different location, or floated 
the main menu and/or toolbar, then Reset Layout does not return these window 
items to their default locations. Instead, you must close the Simplify Console, and 
then open it again.
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Specifying Simplify Suite Options
Typically, after installation, the default values that are specified for Simplify Suite, including 
the Simplify Console, are satisfactory for most organizations and do not require modification; 
however, you always have the option of modifying any or all the default values to better suit 
your working needs. The default Simplify Suite options also include Logging options, which 
can be used to generate a Simplify Suite status log file that provides general information 
about your Simplify Suite installation such OS version, ODBC data sources, and so on, or 
specific log files that are used solely for debugging purposes.

To specify Simplify Suite options
1. On the Simplify Console main menu, click Tools > Options, or on the toolbar, click the 

Options icon .

The Options dialog box opens. 

Figure 1-15: Options dialog box

2. Modify any of the default settings as needed.

If you modify one or more default values, then to reset all values for a selected 
option (page) in a single step, click Page Defaults. To reset all values for all 
options in a single step, click Defaults.

Option Description

Simplify Console

Security Authorization Manager
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3. Click OK.

The Options dialog box closes. The new values are immediately applied to your Simplify 
Suite installation.

Auditing • Audit Control – By default, auditing is enabled. To disable auditing, clear 
Enable Auditing.

• Audit Data Migration Control – If auditing is enabled, then by default, all audits 
for the last 30 days are displayed in the Audit pane. Modify the value in the 
Short Term field as needed.

Note: For detailed information about auditing the Simplify database, see 
“Auditing the Simplify Database” on page 61.

Owners Pane • Load – By default, Ignore Trusted Domains and Preload All Owners at startup 
are not selected. Select one or both of these options to enable them. 

• Search – By default, the maximum number of owners that can be returned by 
a Search is 50. Modify this value as needed.

Objects Pane • Auto-Query Printers on Save – Enabled by default. To disable this option, 
clear it.

• Perform Query Printers as a Background Test – Disabled by default. To enable 
the option, select it.

Product Display Choose which products are to be displayed in the Simplify Console. All products 
are selected by default. To remove a product from the display, clear its selection.
• Simplify Printing
• Simplify Desktop
• Simplify Lockdown
• Simplify Profiles
• Simplify Driver Management
Note: Simplify Stability is a legacy product. For assistance with this product, 

contact Tricerat.

Logging

General Suite Status Log – Click Generate to generate the Suite Status log, which details 
general information about your Simplify Suite installation, including the OS 
version, the Suite and file version, and the relevant ODBC data sources. 
Note: After you click Generate, the Save As dialog box opens, in which you can 

leave the default values for the storage directory and file name for the 
Suite Status log (C:\Program Files\Tricerat\Simplify Suite\Simplify 
Console and SuiteStatus.log) as-is, or you can modify one or both values 
as needed.

Logs Logs – You use these logs strictly for debugging purposes, and you should 
enable them only under the direction of Tricerat support.

Offline Mode

Settings • Enable Offline Mode for Simplify Profiles – By default, disabled. Select Enable 
Offline Mode for Simplify Profiles to enable it. For detailed information about 
Offline mode for Simplify Profiles, see “Simplify Profiles” on page 118.

• Enable Offline Mode for Simplify Desktop – By default, disabled. Select 
Enable Offline Mode for Simplify Desktop to enable it. For detailed information 
about Simplify Desktop, see the Simplify Desktop User Guide.

Option Description
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Simplify Console consists of three primary panes – the Owners pane, the Assignments pane, 
and the Objects pane. This chapter details these three different panes, including their 
structures and functions.

This chapter covers the following topics:

• “The Owners Pane” on page 28.

• “The Assignments Pane” on page 32.

• “The Objects Pane” on page 35.
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The Owners Pane
An owner in the Simplify Console is an entity that can receive assignments and other 
configuration settings. An owner can be one of four types: a user, a group, a computer, or an 
Organizational Unit (OU) /container. Simplify Console pulls in all entities that are in Active 
Directory based on the Windows domain in which it is running and displays these entities in 
a hierarchical tree structure in the Owners pane. A toolbar is displayed at the top of the 
Owners pane. The toolbar displays icons for manipulating the view of the Owners tree, 
searching for specific owners, and refreshing the Active Directory.

Owners pane hierarchical tree structure
See Table 2-2 on page 29 for a description of the items in the Owners pane.

Figure 2-16: Owners pane

In the Simplify Console, OUs and Containers are considered to be the same 
owner type.

2

6

3

1

7

4
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The first level (top-level) in the hierarchy of the Owners tree is as follows:

• The Primary domain, which is the domain of the host computer (the computer on which 
Simplify Suite is installed).

• Trusted domains (0 or more).

• Local Users and groups – Local accounts on the Terminal Server.

• Custom owners - Custom owners are client computers that are specified by either (DSN) 
name, IP address, or a range of IP addresses.

OUs and containers are always found at the second level under the primary domain and/or 
trusted domain entries. Any other second level and below entries in the Owners tree can 
vary widely depending on your organizational needs, but some common structures include 
the following:

• Groups can also be found at the at the second level under the primary domain and/or 
trusted domain entries. 

• Nested OUs are also possible, resulting in third-level and below entries. Groups and/or 
users can be found under second-level OUs and nested OUs.

• Groups and users can also be found at the second level under OUs or Containers, Local 
Users and Groups, and Custom Owners. 

• Computers can be found at the second-level under OUs or Containers.

Unique icons are used to identify the different owner types. An owner’s name is displayed in 
bold in the Owners pane if one or more direct assignments have been made to the owner. 
See Table 2-3 and Figure 2-17 on page 30.

Table 2-2: Owners pane items

Item Description
1 Owners pane toolbar

2 Active Directory primary directory

3 Organizational Units

4 Container

5 Container

6 Local users and groups

7 Customer Owners

For a definition of a direct assignment, see “The Assignments Pane” on page 32.
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Figure 2-17: Owner with a direct assignment

Table 2-3: Owners pane icons

Icon Owner Type
Primary domain or Trusted Domain

Container under a domain or a group under a Customer Owner

Organizational Unit for a domain

Group 

User

Custom Owner (Client computer specified by Name, IP Address, or IP 
Address Range. Groups of custom owners are also allowed.)

The hierarchical structure of the Owners pane is not simply an organizational tool. 
It also serves a practical purpose for inheritance of objects by owners. See “Owner 
Inheritance” on page 39.
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Owners pane toolbar
A toolbar is displayed at the top of the Owners pane. The toolbar displays icons for 
manipulating the view of the Owners tree, searching for specific owners, and refreshing the 
Active Directory.

Figure 2-18: Owners pane toolbar

Icon Description
Expand icon – Expands the Owners tree structure.

Collapse icon – Collapses the Owners tree structure.

Refresh icon – Refreshes the Active Directory.

Search Owners icon – Opens the Search Owners dialog box, which provides options for 
searching owners in the Owners pane. See “To search for owners in the Owners pane” on 
page 44.

Generate Owners Report – TBD
Simplify Suite Administrator Guide 31



Chapter 2
The Simplify Console Panes
The Assignments Pane
The Assignments pane displays the objects and configuration settings that have been 
assigned to the owner that is currently selected in the Owners pane. The Assignments pane 
is comprised of a toolbar and two distinct columns of information. The right column is a 
hierarchical tree structure that is very similar to the tree structure of the Owners pane. The 
structure shows the objects and settings that are assigned to the owner that is currently 
selected in the Owners pane. The name of the currently selected owner is displayed in the 
title bar of the Assignments pane, and the owner name is also displayed as the top level in 
the Assignments tree structure. As you select different owners in the Owners pane, the 
display of objects and configuration settings in the Assignments tree is dynamically updated. 
As you select different branches (objects or settings) in the Assignments tree, the icons on 
the toolbar are also dynamically updated. The right column in the pane indicates the name of 
the owner from which an object was inherited, if applicable, including any owners that are 
causing a denial of the object. 

Figure 2-19: Assignments pane

Item Description
1 AppVUsers owner selected in the Owners pane and displayed in the title 

bar of Assignments pane.

2 Assignments pane toolbar.

3 Inheritance information.

1

2

3
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Two types of assignments are possible in the Assignments pane – a direct assignment and 
an inherited assignment.

• A direct assignment is an active action. To make a direct assignment to an owner, you 
first select the owner in the Owners pane, then you select the object in the Objects pane, 
and then finally, you drag the object to the appropriate branch in the Assignments tree. 

• An inherited assignment is a passive action. All children of an owner automatically inherit 
any assignments that are made to the parent owner. For example, if you assign a printer 
to the Sales Demo domain, then any user who is a member of the Sales Demo domain is 
automatically assigned (inherits) this printer as well. Moreover, any new members that are 
added to the Sales Demo domain also are automatically assigned (inherit) this printer.

Only direct assignments can be deleted from an owner. Inherited assignments are for display 
purposes only and they cannot be deleted; however, they can be designated to be blocked 
or ignored for a particular owner and they can also be denied. Direct assignments can also 
be denied for an owner. See “Managing Assignments” on page 53.

With the exception of the following, all changes that are made to an owner’s assignment or 
configuration data occur exclusively within the Assignments pane:

• Objects/groups are deleted in the Objects pane

• Objects/groups are enabled/disabled in the Objects pane.

• Objects moved in to/out of groups in the Objects pane.

Assignments pane toolbar
Two icons are always displayed on the Assignments pane toolbar – the Expand icon and the 
Collapse icon. These icons function identically in the Assignments pane as they did in the 
Owners pane – to expand or collapse the Assignments tree structure. As you select different 
branches in the Assignments tree, other icons on the toolbar are dynamically updated. 

For detailed information about objects and groups in the Owners pane, see “The 
Objects Pane” on page 35.

Icon Description

Icons that are always displayed

Expand icon – Expands the Assignments tree structure.

Collapse icon – Collapses the Assignments tree structure.
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Icons that are displayed when the owner (top-level) is selected in the Assignments tree

Block Inherited Assignments icon – A toggle for blocking inherited assignments for 
a selected owner and all the owner’s children. Click once to enable blocking. The 
toggle is highlighted with a blue square. Click again to disable blocking. The 
highlighting blue square is removed. See “To block an owner from receiving an 
assignment” on page 58.

Block Server Assignments icon – A toggle for blocking all server assignments for a 
selected owner and the owner’s children. Click once to enable blocking. The toggle 
is highlighted with a blue square. Click again to disable blocking. The highlighting 
blue square is removed. See “To block an owner from receiving an assignment” on 
page 58.

Block Client Assignments icon - A toggle for blocking all client assignments for a 
selected owner and the owner’s children. Click once to enable blocking. The toggle 
is highlighted with a blue square. Click again to disable blocking. The highlighting 
blue square is removed. See “To block an owner from receiving an assignment” on 
page 58.

Block Owner Assignments - A toggle for blocking all of the owner’s (user’s) direct 
assignments as well as all the owner’s inherited assignments. Click once to enable 
blocking. The toggle is highlighted with a blue square. Click again to disable 
blocking. The highlighting blue square is removed. See “To block an owner from 
receiving an assignment” on page 58.

Other icons

Delete Assignment icon – Displayed when a direct assignment is selected in the 
Assignments tree. Click this icon to delete the direct assignment for an owner. See 
“To delete a direct assignment of an object for an owner” on page 56

Deny Assignment icon – Displayed when a either a direct assignment or an 
inherited assignment is selected in the Assignments tree. Click this icon to deny the 
inherited assignment for the parent owner as well as all its children. See “To deny 
an assignment of an object” on page 57.

Permit Assignment icon – Displayed when a denied assignment is selected in the 
Assignments tree. Click this icon to permit the assignment for the parent owner and 
all its children, or just the selected child owner. See “To permit an assignment of an 
object” on page 58.

Select Item in Objects Tree icon – Always displayed when any object (a direct 
assignment, or permitted or denied) is selected in the Assignments tree. Click this 
icon to highlight the object in the Objects Tree and update the object form display 
with the configuration settings for the selected object. 

Icon Description
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The Objects Pane
Objects are things that you can assign to an owner. Examples of objects include 
applications, printers, and configuration settings. An object group is a logical collection of 
objects. You create, configure, and manipulate objects and object groups in the Objects 
pane. The Objects pane is comprised of a toolbar, and two sub-panes that are vertically 
separated. The left sub-pane contains the Objects toolbar and the Objects tree. Objects are 
organized by object type in the Objects tree. The object types that are displayed in the 
Objects tree depend upon the components of the Simplify Suite that your organization has 
licensed. All the objects that are currently defined in the Simplify Suite for the licensed object 
types are displayed in the Objects tree. Objects are sorted alphabetically by name within an 
object type. Depending on the type of object that is selected in the Objects tree, a tabbed 
object form might be displayed in the right sub-pane. 

Figure 2-20: Objects pane

An object form is displayed only if a single object is selected in the Objects pane. 
At all other times, the right sub-pane is blank. 

Item Description
1 Selected object.

2 Objects toolbar. Displayed in left sub-pane.

3 Tabbed object form displayed in right sub-pane for selected object.

32

1
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Object groups
An object group is a logical collection of objects. Object groups are provided in the Simplify 
Console as a convenient mechanism for working with multiple objects at the same time. For 
example, you can use object groups to:

• Group together related objects of a particular type. For example, you can group together 
Word, Excel and PowerPoint application objects under an Office object group.

• Assign a group of objects to an owner instead of assigning each individual object one at 
a time.

• Delete or disable a group to delete or disable all the objects in the group at the same time. 

Object groups are applicable only in the Simplify Console. Nested object groups are not 
supported. The Simplify Suite server components ignore object groups. Only the underlying 
object assignments are considered. When you add/remove objects to/from a group, the 
objects are implicitly assigned to/unassigned from the owners to which the group has been 
assigned. If you delete objects from a group, or you delete the entire object group, then all 
the associated assignments for the objects or group are also deleted. Even if an object is 
part of an object group, you can still independently assign the object. 

Object forms
Depending on the type of object that is selected in the Objects tree, an object form might be 
displayed. An object form groups together related configuration parameters for the selected 
object. The form controls are loaded with the settings for the currently selected object. Each 
object type has its own unique object form.

If you change any setting on a form for a selected object, then an Apply Changes icon  is 
enabled on the Objects pane toolbar. You must click this icon to manually apply the changes 
to the selected object. If you make changes to the configuration parameters for a selected 
object, and then attempt to select another object in the Objects tree before clicking the Apply 
Changes icon, a message opens asking you if you want to apply the changes to the object 
settings. You must click Yes or No in the message dialog box to close the dialog box before 
you can select a different object in the Objects tree.
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Objects pane toolbar
Two icons are always displayed on the Objects pane toolbar: the Expand icon and the 
Collapse icon. These icons function identically in the Assignments pane as they did in the 
Owners pane and the Objects pane – to expand or collapse the tree structure of the pane. As 
you select different objects in the Objects pane tree structure, other icons on the toolbar are 
dynamically updated. 

Icon Description

Icons that are always displayed

Expand icon – Expands the Objects tree structure.

Collapse icon – Collapses the Objects tree structure.

Other icons

Add New Object icon – Displayed when a folder for which it is appropriate to add a 
new object is selected in the Objects tree. Click this icon to add a placeholder in the 
Objects tree for adding a new object. See “To add a new object” on page 47.
Add New Group icon – Displayed when a folders for which it is appropriate to add a 
new object group is selected in the Objects tree. Click this icon to add a placeholder 
in the Objects tree for adding a new object group. See “To add a new object group” 
on page 49.

Delete Selected Item(s) icon – Displayed when one or more objects and/or object 
groups are selected in the Objects tree. Click this icon to delete the objects and/or 
object groups from the Objects tree. See “To delete an object or object group” on 
page 49.
Note: When you delete objects from the Objects tree, the objects are removed 

from the Simplify Driver Management Import Tool and all assignments for 
the objects are also deleted.

Disable Selected Item(s) icon – Displayed when one or more objects and/or object 
groups are selected in the Objects tree. Click this icon to disable the objects and/or 
object groups in the Objects tree. See “To disable an object” on page 50.
Note: When you disable objects in the Objects tree, the objects are not removed 

from the Objects tree nor are any associated assignments deleted. The 
object is simply not effective/operational for any owner to which it is 
assigned. 

Enable Selected Item(s) icon – Displayed when one or more disabled objects and/
or object groups are selected in the Objects tree. Click this icon to enable the 
objects and/or object groups in the Objects tree. See “To enable an object” on page 
51.

Apply Changes icon – Displayed when any existing object is selected in the Objects 
tree and it is enabled when any modification is made to the configuration settings 
for the selected object. Also displayed and enabled after any new object is added to 
the Objects tree. Click this icon to save the configuration settings for any new or 
modified object in the Simplify Driver Management Import Tool.
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Simplify Console

Simplify Console is the management interface for all the Simplify Suite components. Simplify 
Console provides all the functions that are required for administering and maintaining the 
needed owners, objects, and assignments for your Simplify Suite installations.

This chapter covers the following topics:

• “Owner Inheritance” on page 39.

• “Managing Owners” on page 44.

• “Managing Objects” on page 47.

• “Managing Assignments” on page 53.
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Owner Inheritance
Every time the Simplify Suite detects a new login session, the following information is 
examined and analyzed to build the hierarchical structure of the Owners tree:

• The user that is logging in to the system.

• The server that the user is logging in to.

• The client that the user is logging in from.

Each of these three primary owners is used as a foundation to locate additional related 
owners through Active Directory memberships and Custom Owners, which can be Groups, 
Computers, a single IP address, or a range of IP addresses. You can assign objects and 
object groups to these primary owners, or parent owners. Moreover, although OUs, Trusted 
Domains, and Containers are not primary owners in a Simplify Console session, you can 
assign objects or groups of objects to them just the same. Assignments are then inherited by 
the children of a parent owner, which is owner inheritance. 

Owner inheritance determines the final results for all objects that each session of the Simplify 
Suite receives. Consequently, before you begin the process of assigning objects and/or 
object groups to owners and carrying out other administrative tasks in the Simplify Console, 
it is critical that you understand the concept of owner inheritance. This section details the 
following topics that are related to owner inheritance:

• “Assignment conflicts” below.

• “Conflict resolution” on page 41.

• “Advanced features for conflict resolution” on page 43.

Assignment conflicts
When you are assigning objects and settings to owners, you must be aware that some 
objects and settings require a single final result, which means that only one assignment is 
possible to resolve the conflict. Other objects and settings, however, allow for multiple 
assignments.

Single Result Settings

• Shell mode. See the Simplify Desktop User Guide.

• triShell configuration. See the Simplify Desktop User Guide.

• Lockdown mode. See the Simplify Lockdown User Guide.

• ScrewDrivers configuration. See “Simplify Printing” on page 72.

• Default printer setting. See “Simplify Printing” on page 72 or “Simplify Driver 
Management” on page 202.

• Specific policy settings (for example, Drive restrictions). See “Simplify Profiles” on page 
118.
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Multiple Result Settings

• Applications. See “Simplify Profiles” on page 118.

• Printers. See “Simplify Printing” on page 72 or “Simplify Driver Management” on page 
202.

• Registry settings. See “Simplify Profiles” on page 118.

• Specific policy settings (for example, Drive mappings.) See “Simplify Profiles” on page 
118.

In either case, a conflict can occur if the same object is assigned to two different owners, and 
the object is allowed for one of the owners, but denied for the other. For example, Jane Doe 
is a member of the Development Group and the Testing Group, and Printer A has been 
assigned to both groups; however, the printer is allowed for the Development Group and 
denied for the Testing Group. in this case, conflict resolution is a two-step process:

• First, the rank of each assignment is compared, where rank is defined as how close the 
assignment is to the owner. If the ranks of the assignments are different, then the rank of 
the assignment that is closest to the owner takes priority. 

• If the ranks of the assignments are the same, then the inheritance statuses of the 
assignments (Deny or Allow) are compared, where a Deny always takes precedence over 
Allow.

In this example, the ranks of the assignments are identical. As a result, because a Deny 
always takes precedence over an Allow, Jane Doe is denied Printer A. 

See Figure 3-21 below through Figure 3-23 on page 41 for an example of a Deny taking 
precedence over an Allow.

Figure 3-21: Printer assignment - An HP printer is assigned to the IP address range for a 
client computer (a client assignment). Any user who is at the Owings Mills site 
and logs in uses an IP address within this range, and thus, inherits the HP printer.
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Figure 3-22: Printer assignment denied - The HP printer is now denied assignment for the IP 
address range.

Figure 3-23: Assignment to SD Users group - Any user, however, who is a member of the SD 
Users group has been assigned this printer.

What are the results of denying the printer for an IP address range, but directly assigning the 
printer and permitting it for the SD Users group? Any member of the SD users group is 
assigned the HP printer UNLESS they are logging in from a client with an IP address that 
falls within the indicated range. If they log in from a client with an IP address that falls within 
the indicated range, then they are denied the printer assignment.

Conflict resolution
In general, when configuration conflicts arise between owners, the most restrictive setting 
takes precedence; however, there is an ordered approach to conflict resolution, and caveats 
do apply.

The first step in resolving assignment conflicts is to evaluate the owner hierarchy. For 
owners that are found in a tree structure, such as the Active Directory, assignments are 
evaluated from general to specific. This means that in the event of conflicting assignments, 
the owner that is found at a lower level in the hierarchy of the Owners tree overrides the 
owner that is found at the higher level. For example, if a domain is assigned the Explorer 
shell, but an OU is assigned triShell, then an owner in the OU receives trishell because this 
assignment is more specific to a user in the OU.

If the hierarchy is not clear, then conflicts are resolved according to the following:

• Assignments for users versus servers versus clients

• Assignments for owners at the same level (groups)
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For shell and Lockdown settings, the most restrictive setting is chosen to resolve the conflict. 
These settings are hard-coded settings which, from the least restrictive to the most 
restrictive, are the following:

• Shell: Explorer < triShell < No Shell (Deny login)

• Lockdown: Don’t use Lockdown < Learn mode < Use banned list <Use trusted list

For example, if the user hierarchy determines a shell setting of Explorer, but the server 
hierarchy determines a setting of triShell, then the more restrictive setting of triShell is 
applied to the end-user session. 

In the event of Windows Active Directory security groups, Simplify Suite treats the 
assignments that are at this level as more general than the user, but more specific than an 
OU. This applies even if the group is in a different OU than the user. If both the group and the 
user are in different OUs, then the Owners tree is evaluated for parents of both the user and 
the group.

For objects that do not have an inherent order of resolution, several tests are carried out to 
first determine if a resolution is possible. 

• For user/server/client branches, the order of importance from least to most is the 
following: Client < Server < User. For example, if a server has ScrewDrivers Configuration 
A, and the user has ScrewDrivers configuration B, then the end result is ScrewDrivers 
configuration B.

• All groups are weighted higher than any OUs or Containers that are above them in the 
Active Directory. In the case of nested groups, however, the groups that contain the users 
directly are considered more specific to the users, and this results in the overriding of any 
settings that have been applied to groups of groups.

Finally, if none of these tests result in conflict resolution, then, ultimately, the resolution is 
determined by the order in which the objects are retrieved from the Active Directory and 
subsequently read from the Simplify database.

For detailed information about assigning a Shell type to an owner, see the Simplify 
Desktop User Guide. For detailed information about assigning a Lockdown mode 
to an owner, see the Simplify Lockdown User Guide.

Although you can discover this information by reviewing the Tricerat owner 
enumeration on a case by case basis, Tricerat recommends that you use Deny 
Objects where appropriate to obtain a unique result. See “To deny an assignment 
of an object” on page 57.
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Advanced features for conflict resolution
In addition to normal assignment operations, several options are available to manipulate the 
final result of owner assignments. You can:

• Deny any assignment at a lower level in the Owners tree.

• Add the object as a denied object if the object is inherited through any other means.

• Specify that an owner is to ignore entire categories of assignments, which includes 
blocking all objects that are inherited from the tree above them, blocking server 
assignments, blocking client assignments, or blocking user assignments. For example, if 
an administrator is to receive assignments based solely on user membership, then the 
administrator can instruct the domain level to ignore all server and client assignments.

For detailed instructions about implementing advanced blocking features for 
conflict resolution, see “To block an owner from receiving an assignment” on page 
58 in “Managing Assignments.”
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Managing Owners
As the Simplify Console administrator, your duties for managing owners include adding, 
renaming, or deleting custom owners and auditing owners. Before you add a new custom 
owner, you might want to first search for the owner to confirm that it does not already exist, 
and you can also search for owners to review their assignments.

To search for owners in the Owners pane
When you search for owners in the Owners pane, you can search a selected branch of the 
hierarchy, you can search the entire hierarchy, and you can search for one or more owner 
types. You can also specify a search filter to limit the search results.

1. Do one of the following:

• To search for only those owners in a specific branch of the hierarchy, do one of the 
following:

• Select the branch in the Owners pane, and then on the Owners pane toolbar, 
click the Search Owners icon 

• Right-click the branch that is to be searched, and on the context menu that 
opens, click Search.

The Search Owners dialog box opens. The search is set to the branch of the 
hierarchy that is currently selected in the Owners pane.

• To search the entire hierarchy of the Owners pane, on the Owners pane toolbar, 
click the Search Owners icon, and then in the Search Owners dialog box that opens, 
select Entire Tree.

Figure 3-24: Search Owners dialog box

For information about auditing owners, see “Auditing the Simplify Database” on 
page 61.
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2. Select the types of owners for which to search – Users, Computers, Groups, and/or 
Containers.

3. Optionally, to limit the search to only those users that meet specific search criteria, enter 
a search filter in the Filters field.

4. Click Search.

A list of all owners that meet all the search criteria is displayed in the Search Results 
pane of the dialog box.

5. Optionally, in the Search Results pane, select the an owner from the list of search 
results, and then click Select Owner. 

The focus is changed to the Owners pane, and the owner is selected in the Owners 
pane. The display for the Assignments pane is updated accordingly with the objects and 
other configuration settings that have been assigned to or inherited by the owner. See 
“The Assignments Pane” on page 32.

To add custom owners
In the Owners pane, right-click the Computers entry, and on the context menu that opens, 
click Add, and then click the appropriate option.

You must select at least owner type. Remember that in the Simplify Console, OUs 
and Containers are considered to be the same owner type.

Your search is limited to the exact order of the characters in the string, but the 
search string is not case-sensitive and it can be found anywhere in the search 
results. For example, a search string of monitor returns the following owners: 
MONITORIT, Performance Monitor Users, and Simplify Monitoring.

You can also double-click a user in the list of search results.

Option Description
Group Adds an entry for a Group custom owner named NewGroup(n), which can 

contain one or more members. The new entry is automatically selected after 
it is added to the Owners pane.
1. Click the New Group entry, and then name the group as appropriate.
2. Right-click the named group entry, and on the context menu that opens, 

click Add, and then click the appropriate option (Group, Computer, IP 
Address, or IP Address Range).

Note: Groups can be nested. 
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To delete custom owners

To delete a custom owner or a group of custom owners, right-click the customer owner, or 
the custom owner group, and on the context menu that opens, click Delete.

Computer Adds an entry for a Computer custom owner named NewComputer(n) that is 
automatically selected after it is added to the Owners pane. Click the New 
Group entry, and then name the group as appropriate.
Note: Wildcards are supported with named computer owners. Use a 

question mark (?) to specify a single character. Use an asterisk (*) to 
specify multiple characters.

IP Address Opens the IP Address dialog box for specifying the IP address for the custom 
owner. Enter the IP address for the custom owner, and then click OK. 

IP Address Range Opens the IP Address Range dialog box for specifying the range of IP 
addresses for the custom owner. Enter the range of IP addresses for the 
custom owners, and then click OK.

Note: To rename a Group or Computer custom owner, or to specify a different IP address or range 
of IP addresses for a customer owner, right-click the owner in the Owners pane, and on the 
context menu that opens, click Rename.

Option Description

If you delete a custom owner, or you delete a custom owner group, then all the 
nested owners and groups and all their associated assignments are also deleted. 
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Managing Objects
As the Simplify Console administrator, your duties for managing objects include adding 
objects or object groups, specifying configuration settings for objects, deleting objects and 
object groups, disabling/enabling objects, and auditing objects. When you add an object, you 
can add it as a new object, or you can duplicate an existing object, and then modify the 
duplicated object as necessary. You must manually save any new object or any changes that 
you make to an object for the object to be updated in the Simplify database. 

To add a new object
You cannot add a new objects or object group to all branches in the Objects tree. The 
options to add a new object or object group are available only for the lowest level folders 
where it is appropriate to add a new object or object group. For example, you cannot add an 
object or object group at the Printers level or Native Drivers level in the Objects tree, but you 
can add a new object or object group at the Local Printers level. If you can add a new object 
or object group to a folder in the Objects tree, then when you right-click the folder, a context 
menu opens with two options: New Object and New Group. The (1) New Object icon and the 
(2) New Group icon are also displayed on the Objects pane toolbar.

Figure 3-25: Objects pane toolbar with options for adding a new object or new object group

1. Do one of the following:

• Right-click the folder in the Objects tree to which the new object is to be added 
(Application, Print Server, and so on), and on the context menu that opens, click 
New Object.

• Click the folder in the Objects tree to which the new object is to be added 
(Application, Print Server, and so on), and then on the Objects pane toolbar, click the 
New Object icon .

A placeholder named New Object is created in the Objects tree, and it is automatically 
selected. A tabbed form for specifying the object’s configuration settings opens in the 
right sub-pane. The Objects pane toolbar is dynamically updated with icons, which from 
left to right are Delete Selected Item(s) , Disable Selected Item(s) , and Apply 

Changes . See Figure 3-26 on page 48.

For information about auditing objects, see “Auditing the Simplify Database” on 
page 61.

1 2
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Figure 3-26: Objects pane with a placeholder for adding a new object and object form

2. Enter the name for the new object.

3. In the object form, enter the configuration settings for the object.

4. On the Objects pane toolbar, click the Apply Changes icon.

To duplicate an object
You can duplicate an existing object, and then modify the name and configuration settings as 
needed to add a new object to the Objects tree.

1. Right-click the object that is to be duplicated, and on the context menu that opens, click 
Duplicate.

A placeholder named Copy (n) of (Object Name) is created in the Objects tree, and it is 
automatically selected. An object form for specifying the object’s configuration settings 
opens in the right sub-pane. It is pre- populated with the configuration settings for the 
duplicated object.

2. Enter the name for the new object.

3. In the object form, modify the configuration settings for the object.

4. On the Objects pane toolbar, click the Apply Changes icon.

Object names are stored internally by an object ID. As a result, you can use the 
same object name as needed; however, to avoid confusion, Tricerat does not 
recommend that you do so. To rename an object, right-click the object in the 
Objects tree, and on the context menu that opens, click Rename.

Object names are stored internally by an object ID. As a result, you can use the 
same object name as needed; however, to avoid confusion, Tricerat does not 
recommend that you do so. To rename an object, right-click the object in the 
Objects tree, and on the context menu that opens, click Rename.
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To add a new object group
If you can add a new object or object group to a folder in the Objects tree, then when you 
right-click the folder, a context menu opens with two options: New Object and New Group. 
The (1) New Object icon and the (2) New Group icon are also displayed on the Objects pane 
toolbar.

Figure 3-27: Objects pane toolbar with options for adding a new object or new object group

1. Click the folder in the Objects tree to which the new object group is to be added, and 
then do one of the following:

• Right-click the folder, and on the context menu that opens, click New Group.

• On the Objects pane toolbar, click the New Group icon.

A placeholder named New Group is created in the Objects tree, and it is automatically 
selected. 

2. Enter the name for the new object group.

3. To add new objects to the group, do one or both of the following as appropriate:

• Right-click the object group folder, and on the context menu that opens, click New 
Object, and then add the new object accordingly. See “To add a new object group” 
on page 49.

• Click and drag any object from its current location in the Objects tree to the new 
object group folder.

To delete an object or object group
You can delete one or more objects from the Objects tree. You can delete “standalone”: 
objects, you can delete objects from an object group, or you can delete an entire object 
group. When you delete objects from the Objects tree, the objects are removed from the 
Simplify database and all assignments for the objects are also deleted. If an object must 
again be assigned to an owner or owners, then you must first add the object back to the 
Objects tree.

1. If you are deleting objects from an object group, expand the object groups folder to 
display the list of objects in it. 

To rename an object group, right-click the group folder in the Objects tree and on 
the context menu that opens, click Rename.

1 2
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2. Do any of the following as needed: 

• To delete a single object, do one of the following: 

• In the Objects tree, right-click the object that is to be deleted, and on the context 
menu that opens, click Delete.

• In the Objects tree, select the object that is to be deleted, and then on the 
Objects pane toolbar, click the Delete Selected Item(s) icon.

• To delete multiple objects and/or object groups, do one of the following:

• Press and hold the CTRL key, and in the Objects tree, select the objects and/or 
object groups that are to be deleted, and then right-click any selected object or 
object group and on the context menu that opens, click Delete.

• Press and hold the CTRL key, and in the Objects tree, select the objects and/or 
object groups that are to be deleted, and then on the Objects pane toolbar, click 
the Delete Selected Item(s) icon.

A Simplify Console message opens, asking you to confirm that the selected items 
are to be deleted.

3. Click Yes.

The message closes. The objects are deleted and the Objects tree is dynamically 
updated. Any assignments for the objects are also deleted. 

To disable an object
You can disable one or more objects in the Objects tree, and you can disable all objects in an 
object group in a single step. When you disable objects in the Objects tree, the objects are 
not removed from the Objects tree nor are any associated assignments deleted. The object 
is simply not effective/operational for any owner to which it is assigned. For example, if you 
need to take a printer down for maintenance, but you do not want to delete any associated 
assignments, then you can disable the printer object. Although the printer assignments 
remain intact, any affected owner will not be able to print from the printer. After the printer is 
repaired, you can enable the printer, and all the affected owners can then print from it again.

1. If you are disabling individual objects in an object group, expand the object groups folder 
to display the list of objects in it. 

2. Do any of the following as needed: 

• To disable a single object or all the objects in a single object group, do one of the 
following: 

• In the Objects tree, right-click the object or object group that is to be disabled, 
and on the context menu that opens, click Disable.

• In the Objects tree, select the object or object group that is to be disabled, and 
then on the Objects pane toolbar, click the Disable Selected Item(s) icon.

• To disable multiple objects and/or object groups:

• Press and hold the CTRL key, and in the Objects tree, select the objects and/or 
object groups that are to be disabled, and then right-click any selected object or 
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object group and on the context menu that opens, click Disable.
• Press and hold the CTRL key, and in the Objects tree, select the objects and/or 

object groups that are to be disabled, and then on the Objects pane toolbar, click 
the Disable Selected Item(s) icon.

A red “X” is displayed on the icon for any disabled object. If all the objects in an 
object group have been disabled at the group level, then a red “X” is displayed on 
the icon for the object group.

Figure 3-28: Disabled objects displayed in the Objects tree

To enable an object
You can enable one or more objects in the Objects tree, and you can enable all objects in an 
object group in a single step. You can also individually enable in an objects group that was 
initially disabled at the objects group level. A red “X” is displayed on the icon for any disabled 
object. If all the objects in an object group have been disabled at the group level, then a red 
“X” is displayed on the icon for the object group. When you select a disabled object or object 
group in the Objects tree, an Enable Selected Item(s) icon  is displayed in place of a 
Disable Selected item(s) icon on the Objects pane toolbar.

1. If you are enabling individual objects in an object group, expand the object group folder 
to display the list of objects in it. 

Item Description
1 All objects in the object group disabled at the group level.

2 Object individually disabled.

1

2
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2. Do any of the following as needed: 

• To enable a single object or all the objects in a single object group, do one of the 
following: 

• In the Objects tree, right-click the object or object group that is to be enabled, 
and on the context menu that opens, click Enable.

• In the Objects tree, select the object or object group that is to be enabled, and 
then on the Objects pane toolbar, click the Enable Selected Item(s) icon.

• To enable multiple objects and/or object groups, do one of the following:

• Press and hold the CTRL key, and in the Objects tree, select the objects and/or 
object groups that are to be enabled, and then right-click any selected object or 
object group and on the context menu that opens, click Enable.

• Press and hold the CTRL key, and in the Objects tree, select the objects and/or 
object groups that are to be enabled, and then on the Objects pane toolbar, click 
the Enable Selected Item(s) icon.

The enabled objects remain selected. The red “X” is removed from the object icons. The 
Disable Selected Item(s) icon is displayed again on the Objects pane toolbar.
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Managing Assignments
Assigning an object is the act of selecting an object or object group and associating the 
object or object group with a specific owner. To assign an object, you first select the owner in 
the Owners pane, then you select the object in the Objects pane, and then, finally, you drag 
the object to the appropriate branch in the Assignments pane. 

Assignments are made in three primary locations and then merged into a single list in the 
Assignments pane:

• The user assignments – Any object that is assigned directly to the user who is logging in, 
or any Group/Domain/OU of which the user is a member. For example, as shown in 
Figure 3-29 below, (1) an HP printer is assigned directly to the SD Users group, and (2) 
any user who is a member of the SD Users group inherits the HP printer.

Figure 3-29: User assignment example

If a selected object/object group cannot be assigned to a branch of the 
Assignments pane, then as you drag the object over the branch, a Not Allowed 
icon  is displayed.

1

2
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• The server assignments – Any object that is assigned directly to the server (Terminal 
Server or Virtual Desktop) or any Group/OU/IP range of which the server is a member. 
For example, in Figure 3-30 below, the Task Manager application is assigned to the 
server at the Desktop level. This application is inherited on the desktop of any user who 
logs in to the server. 

Figure 3-30: Server assignment example

• The client assignments – Any object that is assigned to the client in the Active Directory, 
a client name in Custom Owners, or to an IP address. For example, in Figure 3-31 below, 
an HP printer is assigned to the client/workstation in the Computers container. Any user 
who log in to a Virtual Desktop/Terminal Server from the client inherits the printer.

Figure 3-31: Client assignment example
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As the Simplify Console administrator, in addition to making direct assignments, your duties 
for managing assignments include deleting direct assignments, denying or permitting 
assignments, and blocking owners from receiving one or more assignment types. 

To make a direct assignment of an object/object groups to an 
owner

When you make a direct assignment of an object or object groups to an owner, the 
assignment is automatically saved to the Simplify database. No manual action to save the 
assignment is required. The only objects that you cannot directly assign to an owner are 
ScrewDrivers v6 Printer Server objects. You can assign only the nested printers. Also, 
neither ScrewDrivers v6 Print Server groups nor ScrewDrivers v6 Print Server Printer groups 
are allowed.

1. In the Owners pane, select the owner to which the objects or object groups are being 
assigned.

2. In the Objects pane, select the object or object group that is being assigned. Note the 
following: 

• To select multiple objects or object groups, press and hold the CTRL key as you 
make your selections.

• To assign all the objects in the object group in a single step, select the top-level 
object group folder. 

• To assign only specific objects in an object group, expand the top-level object group 
folder, and then select the object or objects as appropriate.

Your management of assignments can be affected by two variables – the Shell 
type and/or Lockdown mode that has been assigned to the owner. For detailed 
information about assigning a Shell type to an owner, see the Simplify Desktop 
User Guide. For detailed information about assigning a Lockdown mode to an 
owner, see the Simplify Lockdown User Guide.

If Simplify Printing or Simplify Driver Management has been licensed, then an 
owner can have one or more different printers assigned to it, and you can set one 
of these printers as the owner’s default printer. For detailed information about 
Simplify Printing or Simplify Driver Management, including the specifying of a 
default printer for an owner, see “Simplify Printing” on page 72 or “Simplify Driver 
Management” on page 202.

You can multi-select only objects and groups. You cannot multi-select a group and 
one or more of its nested objects. 
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3. Drag the selected objects or object groups to the appropriate branch in the Assignments 
pane.

To delete a direct assignment of an object for an owner
You can delete only direct assignments and you can delete only one direct assignment of an 
object at a time.

1. In the Owners pane, select the owner from which the object is being deleted.

2. Expand the Assignments tree as needed to find the object.

3. Do one of the following:

• Right-click the object and on the context menu that opens, click Delete Assignment.

• Select the object, and the on the Assignments pane toolbar, click the Delete 
Assignment icon .

A Delete Assignment dialog box opens, asking you to confirm the deletion of the 
selected object.

4. Click OK.

Depending on the object that is selected for deletion, for example, a printer versus an 
application, the Shell type that is assigned to the owner, and/or the Lockdown mode that 
is assigned to the owner, two results are possible:

• The Delete Assignment dialog box closes and the direct assignment is immediately 
deleted.

• A series of Deletion Confirmation messages opens, asking you to confirm other 
deletion actions. For example, if you are deleting an application such as Microsoft 
Word from a server, and Lockdown mode is enabled for the owner, you are asked if 
you also want to delete the application from the Trusted Applications list. Click Yes 
or No for each additional Deletion Confirmation message as appropriate. After you 
answer the last message in the series, the direct assignment is deleted from its initial 
location in the Assignments tree (the location that you selected for deletion), as well 

If a selected object/object group cannot be assigned to a branch of the 
Assignments pane, then as you drag the object over the branch, a Not Allowed 
icon  is displayed.

Although you cannot delete an inherited assignment, you can deny it. See “To 
block an owner from receiving an assignment” on page 58.

To view the location of an object in the Objects tree before you delete its 
assignment, right-click the object and on the context menu that opens, click Select 
in Objects Tree. 
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as any other locations that you have specified.

To deny an assignment of an object
You can delete or deny any direct assignment; however, if an owner has inherited an 
unnecessary or unwanted assignment, you cannot delete the assignment. Instead, you must 
deny the assignment. When you deny either a direct assignment or an inherited assignment, 
the denied state of the assignment is also inherited – if a parent owner is denied an 
assignment, then all its children are also denied the assignment. 

1. In the Owners pane, select the owner for which the assignment is being denied.

2. Expand the Assignments tree as needed to find the object.

3. Do one of the following:

• Right-click the object and on the context menu that opens, click Deny Assignment.

• Select the object, and the on the Assignments pane toolbar, click the Deny 

Assignment icon .

The object is marked with a Denied icon in the Assignments tree and the Denied by 
<owner name> is displayed in the Inherited From column.

Figure 3-32: Example of a denied application object in the Assignments pane

For detailed information about assigning a Shell type to an owner, see the Simplify 
Desktop User Guide. For detailed information about assigning a Lockdown mode 
to an owner, see the Simplify Lockdown User Guide.

Remember, a denied assignment of an object always overrides any Permitted 
assignment, so make sure that when you are denying an object, that you set the 
deny at the appropriate level in the Assignments tree. 

You can deny only inherited assignment for one owner at a time using the 
following procedure. To deny all inherited assignments for an owner in a single 
step, see “Advanced features for conflict resolution” on page 43.
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To permit an assignment of an object
You can always override the Denied status of an object and permit its assignment again. You 
can permit the assignment of an object at the parent owner level, which means that the 
assignment is also permitted for all the parent owner’s children, or you can selectively permit 
the assignment of any child one at a time.

1. In the Owners pane, select the owner for which the assignment is being permitted.

2. Expand the Assignments tree as needed to find the object.

3. Do one of the following:

• Right-click the object and on the context menu that opens, click Permit Assignment.

• Select the object, and the on the Assignments pane toolbar, click the Permit 
Assignment icon .

The Denied icon is removed from the object in the Assignments tree. The name of the 
owner from which the object inherited its assignment is displayed in the Inherited From 
column.

To block an owner from receiving an assignment

In addition to normal assignment operations, several options are available to manipulate the 
final result of owner assignments, including specifying that an owner is to ignore entire 
categories of assignments. For example, if an administrator is to receive assignments based 
solely on user membership, then the administrator can instruct the domain level to ignore all 
server and client assignments. You can specify any of the following:

• Block all objects that are inherited from the tree above them.

• Block server assignments.

• Block client assignments.

• Block user assignments.

1. In the Owners pane, select the appropriate owner.

Remember, a Denied assignment of an object always overrides any Permitted 
assignment, so if you cannot enable the assignment for an object, check to see if 
the assignment is denied for its parent owner. 

The following settings are typically used only in advanced configurations. Contact 
support@tricerat.com for assistance. 
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2. At the top-level of the Assignments pane, right-click the owner name, and on the context 
menu that opens, select the appropriate option or options.

Option Description
Block Inherited Assignments Blocks all inherited assignments for the owner.

Block Server Assignments Blocks all assignments that the owner inherits from the server 
that is being logged in to.

Block Client Assignments Blocks all assignments that are made to client computers as 
well as all the computers that are defined in the Computers 
container.

Block User Assignments Blocks all of the user’s (owner’s) direct assignments as well as 
all the user’s inherited assignments.

A check mark is displayed in front of any option that is currently selected for the 
owner. To turn off an option, click the option again. The check mark is removed, 
indicating that the option is not currently selected for the owner.
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Two primary functions are available in the Simplify Console for reviewing and analyzing the 
data in your Simplify database: audits and reports. Audits track all the changes that have 
been made to an entity in the Simplify database in a specified time period such as the create 
and update for an application object. Other Simplify Suite reports provide different 
information about your Simplify Suite installation, such as all the objects that are currently 
assigned by owner. 

This chapter covers the following topics:

• “Auditing the Simplify Database” on page 61.

• “Generating Simplify Suite Reports” on page 66.
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Auditing the Simplify Database
Audit is a management tool in the Simplify Console that tracks all the changes made to the 
Simplify database. Three options are available for auditing these changes:

• Audit Object – This audit tracks the history of an object since its initial creation date.

• Audit Owner – This audit tracks the history of all the assignments ever made to an owner.

• Searching Audit Data – This option allows you to search for specific audit data based on 
user-specified search criteria such as Users, Actions, and so on.

To audit an object or owner object in the Simplify database
1. Do one of the following:

• To audit an object, in the Objects pane, right-click the appropriate object, and on the 
context menu that opens, click Audit.

• To audit an owner, in the Owners pane, right-click the appropriate owner, and on the 
context menu that opens, click Audit.

The audit results are contained in an Audit pane. By default, the pane is initially 
collapsed into a tab that is docked at the bottom left edge of the Simplify Console 
window.

Figure 4-33: Collapsed Object Audit tab 

2. Click the Audit tab to open the Audit pane and review the data for the selected object or 
owner. See “Audit pane” on page 62.

Remember, you can change the location of the Audit pane to better suit your 
working needs. See “Customizing the Simplify Console Layout” on page 19.
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Audit pane
When you click an Audit tab to open the corresponding Audit pane, by default, it opens at the 
bottom of the Simplify Console window. An Audit pane is comprised of a toolbar, and two 
sub-panes: the History sub-pane and the Value sub-pane.

Figure 4-34: Audit tab

Audit pane toolbar
The Audit pane toolbar is located at the top of the History sub-pane (the left sub-pane).

Figure 4-35: Audit pane toolbar

Every time you carry out an audit during a Simplify Console session, a new Audit 
tab does not open. Instead, the Audit tab is updated with the name of the entity 
that was most recently audited. You can use the options on the Audit toolbar to 
scroll through the all the audits that, by default, were carried out in the last 30 days 
for your Simplify Suite installation. See “Audit pane toolbar” below.

Icon Description
Back icon – Scroll backwards through all the audits that, by default, were carried 
out in the last 30 days by any user for your Simplify Suite installation. As you 
scroll through backwards through the audits, the title bar of the Audit pane is 
updated accordingly. 
Note: To change the default time period for an audit, see “Specifying Simplify 

Suite Options” on page 25.

Forward icon – Scroll backwards through all the audits that, by default, were 
carried out in the last 30 days by any user for your Simplify Suite installation. As 
you scroll through forward through the audits, the title bar of the Audit pane is 
updated accordingly. 
Note: To change the default time period for audits, see “Specifying Simplify 

Suite Options” on page 25.
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Audit sub-panes
The History sub-pane is on the left, and by default, it displays the following information for all 
the actions carried out on the database record for the last 30 days sorted in reverse 
chronological order:

• The Record Type.

• The Action that was carried out for the object such as Create or Update.

• The Date that the action was carried out.

• The User who carried out the action.

• Any comments that the user entered for the action.

The Value sub-pane is on the right, and it displays the following information for the record 
that is currently selected in the History pane:

• The Field that contains the affected value.

• The Old Value (if applicable).

• The New Value.

To change the sort order of the records in the History sub-pane, click any in column header. 
For example, to sort alphabetically by Action, click in the Action column. To sort in reverse 
alphabetical order by Action, click the Action column again.

Clear icon – Click this icon to clear all the records that are currently displayed in 
the Audit pane. 
Note: This action clears only the display of the Audit pane. It does not clear the 

Audit records from the Simplify database. 

Refresh Audit Data icon – Click this icon to update/refresh the display in the 
Audit pane.

Search Audit Data icon — Click this icon to open the Search Audit Data dialog 
box. You use the options on the dialog box to search for audit records in the 
Simplify database, and then you can limit the database audit to a selected owner 
or object. See “To search for audit data” on page 64.

Generate Audit Report – TBD

The Comment field is a free text field. You can double-click in this field to add a 
comment for the database record.

Icon Description
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To search for audit data
1. If you have not already done so, audit an object or owner. See “To audit an object or 

owner object in the Simplify database” on page 61.

2. On the Audit tab toolbar, click the Search Audit Data icon .

The Search Audit Data dialog box opens. 

Figure 4-36: Search Audit Data dialog box

3. Specify your search criteria. 

• You can leave all values set to their default values, or you can modify them as 
needed. 

• If you limit the results by a search string, the search is not-case sensitive, and the 
search string can appear anywhere in the search results, but the search is limited to 
the exact order of the characters in the search string. 

4. Click Search.

All the database records that match the search results are displayed in the Search 
Results pane at the bottom of the Search Results dialog box.

To view assignments that were made by different SQL accounts, search by User 
(and not by Owner). In larger environments, it might be suitable to create a 
separate SQL account (or granting db_owner to administrator accounts for the 
Simplify database) for tracking purpose.
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5. Optionally, to audit a specific database entity, do the following:

a. In the Search Results pane, right-click the appropriate record type, and on the context 
menu that opens, click Audit, and then on the second context menu that opens, click 
the <Record Type>. 

Figure 4-37: Auditing an Owner record type

A closed Audit tab is docked at the bottom of the Simplify Console window. 

b. Click the closed Audit tab to open the Audit pane and view and work with the audit 
data.
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Generating Simplify Suite Reports
Different Simplify Suite reports provide different information about your Simplify Suite 
installation, such as all the objects that are currently assigned by owner. Currently, you can 
generate two Simplify Suite reports from the Simplify Console:

• Assigned Objects Owner report - Details all the objects that are assigned in your Simplify 
database that are assigned to owners. The report is organized by owner.

• Assigned Owners by Object report – Details all the owners in your Simplify database to 
which objects have been assigned. The report is organized by object.

To generate a Simplify Suite report
On the Simplify Suite main menu, click Reports, and then select the appropriate report 
option: Assigned Objects by Owner or Assigned Owners by Object.

The selected report opens in a ReportViewer window. The toolbar at the top of the 
window contains options for working with the report such as searching for information in 
the report, printing the report, and so on. See Figure 4-38 below and Figure 4-39 on 
page 67.

Figure 4-38: Assigned Objects by Owners report

Before you can generate any Simplify Suite report, a specific runtime version for 
Crystal Reports must installed on the host computer. If this version is not installed, 
then after you click the Generate Report icon, a ReportViewer Warning dialog box 
opens, informing you of this, and providing a link to download the appropriate 
version of the installation files. You can also contact support@tricerat.com for 
assistance. 

You might have to click a ReportViewer icon  in the Windows taskbar to open 
and view the report after it is generated.
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Figure 4-39: Assigned Owners by Object report
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The Simplify Console has many tools that are designed for retrieving and manipulating the 
data that is relevant to the operation of the Simplify Suite, and for configuring the console 
and/or the Simplify Suite.

This chapter covers the following topics:

• “The Simplify Console Tools Menu” on page 69.

• “The Manage Data Sources Tool” on page 71.
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The Simplify Console Tools Menu
To access the Tools menu, on the Simplify Console main menu, click Tools. The following 
options are found on the Tools menu:

Option Description
External Opens a dropdown menu with options for the following external 

tools: RegDiff, Simplify Migration Utility, and AppChecker. The 
menu also contains a Customize Option, which opens the 
Customize External Tools dialog box. You use the options on 
this dialog box to customize any of these external tools to 
better suit your working needs. See:
• “The RegDiff Tool” on page 189.
• “Simplify Migration Utility” on page 197.
Note: For assistance in using any of these external tools, 

contact support@tricerat.com.

Note: The following six options are used in Simplify Lockdown. For detailed information about 
Simplify Lockdown, see the Simplify Lockdown User Guide.

Configure Simplify Lockdown Opens the Simplify Lockdown Configuration dialog box in 
which you can set the service options for the Lockdown 
service, restart the service and/or purge the Simplify database 
tables related to Simplify Lockdown. 

Customize Lockdown Messages Opens the Customize Lockdown Messages dialog box. You 
use the options on this dialog box to customize the messages 
that a user receives while within a Simplify Suite session when 
an application is being locked down. 

Services Provides options for stopping, starting, or restarting the 
Simplify Printing service.
Note: The Simplify Stability option is a legacy option and is no 

longer applicable for Simplify Suite.

Import Learn Mode Apps Opens the Import Learn Mode Application dialog box. You use 
the options on this dialog box to import applications that are 
accessed by users who are in Learn Mode can be imported. 

Show Users in Learn Mode Opens a list of users for whom Learn Mode has been turned 
on. 

Show Denied Apps Opens a list of objects that have been added to the banned list. 
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Find Apps to Import Opens the Search for and Create Application Objects dialog 
box. You use the options on this dialog box to search for 
applications that you want to import in to your Simplify Suite 
installation and create application objects for these imported 
applications. 

Figure 5-40: Search For and Create Application Objects 
dialog box

Options See “Specifying Simplify Suite Options” on page 25.

Option Description
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The Manage Data Sources Tool
You use the Manage Data Sources tool to manage the following database connection 
properties:

• The connection properties for the Simplify Console. (View/Set Application Data Source).

• The connection properties for all the users that are connecting to the Simplify Suite 
server. (View/Set Simplify Data Source.)

You can also use the tool to manage the ODBC data source for Simplify Suite. If the 
connection to the Simplify Suite is incorrect, or if it changes, then you can use the options 
that are available from the Manage Data Sources tool to specify the ODBC DSN and the 
correct credentials for the Simplify Suite to connect to the Simplify database.

To open the Manage Data Sources tool, on the Simplify Console main menu, click File > 
Manage Data Sources.

Figure 5-41: Manage Data Sources dialog box

Typically, these values are the same for both data sources, but in the event that 
they must be different, you can contact support@tricerat.com for assistance.

Generally, after the initial installation of the Simplify Suite and under normal 
operating conditions, you do not have to modify the data source values or 
administer the ODBC data source for Simplify Suite. For additional information 
about installing and configuring the Simplify Suite, see the Simplify Suite 
Installation Guide.
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Section 2
Simplify Printing

Section Contents
• Getting Started with Simplify Printing on page 73

• Managing Printer Objects in Simplify Printing on page 78

• Managing ScrewDrivers Objects and Settings on page 100

• ScrewDrivers Troubleshooting on page 110

This section thoroughly details the management and use of 
Simplify Printing. For a high-level overview of the core 
components of Simplify Printing and the essentials for 
installing Simplify Printing and using it immediately, see the 
Simplify Printing Quick Start Guide.



Chapter 1
Getting Started with Simplify 
Printing

Simplify Printing is a print driver solution for Windows environments that uses Tricerat’s 
ScrewDrivers technology and a Print Server plug-in to overcome remote printing limitations. 
This chapter provides information about using the Simplify Console for managing your 
Simplify Printing instance. It also provides a high-level overview of the ways that different 
clients can interact with Simplify Printing. 

This chapter covers the following topics:

• “Accessing Simplify Printing” on page 74.

• “Client Interactions with Simplify Printing” on page 75.
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Accessing Simplify Printing
If your organization has licensed Simplify Printing, then after you log in to the Simplify 
Console, a Printers entry is displayed in the Objects pane.

Figure 1-42: Printers entry in the Objects pane of the Simplify Console

For information about opening and logging in to the Simplify Console, see 
“Simplify Console Overview” on page 13.
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Client Interactions with Simplify Printing
Simplify Printing is a print driver solution for Windows environments that uses Tricerat’s 
ScrewDrivers technology and a Print Server plug-in to overcome remote printing limitations. 
The ScrewDrivers component of Simplify Printing is the client-server solution for remote 
printing limitations. The ScrewDrivers client can be installed on any Windows client. The 
ScrewDrivers client queries the print drivers to make a list of all the features (color, DPI, 
paper sizes, and so on) that are available for all the printers that are local to the Windows 
client, and then passes these settings to the ScrewDrivers Server. The ScrewDrivers Server 
then uses the ScrewDrivers virtual driver to virtualize the drivers. The Print Server plug-in 
can communicate directly with any print server printer. This means that clients on which the 
ScrewDrivers client cannot be installed, such as a macOS client using RDP or a smartphone 
can still print in Citrix and Terminal servers, virtual desktops, and so on directly to print server 
printers. See “Print Server Printing through Simplify Printing” on page 76.

Figure 1-43: Client interactions with Simplify Printing

For detailed information about ScrewDrivers, including its infrastructure and 
communication pathways, see the ScrewDrivers’s Administrator Guide.
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Print Server Printing through Simplify Printing
Because Simplify Printing can be installed on Windows fat clients, no print driver 
management is required on client PCs. Moreover, because ScrewDrivers supports any 
Windows-based driver, implementing Simplify Printing completely eliminates driver 
management on Terminal Servers, Virtual Desktops, and so on. This means that as the 
Simplify Suite administrator, you can consolidate the print drivers and spooling to your print 
servers, which is particularly applicable if the print server is across a WAN. 

As shown in Figure 1-44 below, in a typical Simplify Printing installation, there are two 
components to print server printing through Simplify Printing – the Simplify Printing server 
(Terminal Server, Virtual Desktop, and so on) and the print server. The Simplify Printing 
server acts as the ScrewDrivers Server. Using the functions that are available in the Simplify 
Console, you can specify which users and/or groups are to be able to print to specific 
printers from the print servers. The print server component acts as the ScrewDrivers client. 
The print server builds its local and network printers to the ScrewDrivers Server. Any print job 
that a user starts goes directly from the Citrix and Terminal servers, virtual desktops, and so 
on to the print server. As a result, no spooling occurs on a client’s local machine and all print 
information is sent between the servers instead of the server and the client.

Figure 1-44: Print server printing through Simplify Printing without proxy 

For some managed service provider (MSP) environments, however, a third component—a 
Simplify Printing Print Server proxy feature—might be required. As shown in Figure 1-45 on 
page 77, this proxy feature reverses the direction of the initial communication between the 
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print server clients and the print server. This feature requires the installation of one additional 
component within the network where the ScrewDrivers-based queues print and one 
additional component for each remote network that these queues must access

Figure 1-45: Print server printing through Simplify Printing with proxy 
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After you have set up your Simplify Printing environment (for example, consolidating the print 
drivers and spooling to your print servers), at a minimum, you must add, assign, and 
configure the necessary print server printers for your users. Depending on your Simplify 
Printing environment, you might also enable print server advanced print features, and/or 
assign specific printers to users.

This chapter covers the following topics:.

• “Managing Print Server Printers” on page 79.

• “Viewing Print Server Print Jobs” on page 95.

• “Setting Up a Failover Print Server” on page 97.
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Managing Print Server Printers
After you have set up your Simplify Printing environment (for example, consolidating the print 
drivers and spooling to your print servers), at a minimum, you must add, assign, and 
configure the necessary print server printers for your users. Adding and configuring print 
server printers consists of the following steps:

1. Adding the print server object and importing all the printers for the print server object. 
See “To add the Simplify Print Server object and import the associated printers” below.

2. Assigning the print server printers to the appropriate owners. See “To assign the print 
server printers” on page 85.

3. Configuring the assigned print server printers. See “To configure the print server 
printers” on page 88.

To add the Simplify Print Server object and import the associated 
printers

You must do the following procedure for each print server on which the Simplify Printing 
agent was installed.

1. In the Objects pane, under the ScrewDrivers > <Version Number> Print Servers folder, 
create a new object and give the object the name of your organization’s print server, for 
example, qa-srv005.

In the right sub-pane of the Objects pane, the Object Form for the new print server object 
is displayed. The General tab is the open tab. The Hostname or IP is set to 0.0.0.0 and 
the port is set to the default value of 3550. See Figure 2-1 on page 80. Table 2-1 on page 
80 details the options that are available on the five tabs of the print server object form. 

The order of steps presented below for creating the Simplify Print Server object is 
not absolute. You can determine which order best suits your working needs. For 
example, you can name the Simplify Print Server object immediately after you 
create the object instead of after specifying the hostname for the object. 

To review how to add objects in the Simplify Console, see “Managing Objects” on 
page 47.

When working in Simplify Printing, you might see the legacy term “ScrewDrivers” 
on various tabs, in lists, and so on. This term will be updated to the correct term 
“Simplify Print” in a future release.
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Figure 2-1:  Simplify Console with new Print Server object entry, General tab

Table 2-1: Print Server Object form 

Option Description
General tab
Print Server Properties
Hostname or IP The hostname or IP address of the print server.

Port Indicates the port on which the print server listens. The default value is 
3550 and you should change this value only if there is a conflict on the 
port.

Connection ID A system-generated ID for the print server.

Test Connection Click to confirm that the print server is available, and the configuration 
values for Hostname/IP and Port are correct.

Queries
Refresh All Printers Opens a connection to the print server and requests to refresh the entire 

list of printers that are currently installed on the print server. New 
printers that have been added since the last refresh are also added to 
the list.
Note: This option is particularly applicable if changes have been made 

to the print server, such as driver updates, which must be re-
queried for accurate printing.

Import New Printers Opens a connection to the print server and requests to refresh the list of 
current printers with only the new printers that have been installed on 
the print server since the last refresh.
Note: This option is faster than refreshing the entire list.

Options
Use Database Cached 
Printer Information

Select this option to build your users’ printers based on information that 
is cached in the Simplify database instead of querying the print server 
during login. 
Note: This option can improve performance, but if changes have taken 

place with the print server such as updating a print driver, then 
you must first refresh the list of printers before using this option.
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2. On the General tab, replace the default hostname with the actual name of the print 
server and if necessary, change the default port.

Impersonate User 
When Printing

Selected by default and Tricerat recommends that you leave this option 
selected. When a job is sent to the print spooler, the print job will show 
as being originated by the user instead of by the system.

Tricerat Advanced Print Features - You can enable/disable advanced printer features on a per 
printer basis, or at the global level (all printers assigned to a selected Simplify Print Server object. 
See “To enable/disable access to the advanced features for a print server printer” on page 92.

Default to Not Use 
Advanced Print 
Features

Selected by default. Disables access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object. For access 
to the advanced features for all the printers to the Simplify Print Server 
object, one of two options must be selected:
• “Default to Use Advanced Features Indirect.”
• “Default to Use Advanced Features Direct.”

Default to Use 
Advanced Features 
Indirect

Select this object to enable access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object, When this 
option is selected, after a user clicks Preferences in the Print dialog box, 
the Printing Preferences dialog box opens with an Advanced Print 
Features tab. The user then must open the Advanced Print Features 
tab, and click Show UI to open the Manufacturer’s Print dialog box for 
the selected printer. The dialog box displays the advanced features that 
the manufacturer supports for the printer.

Default to Use 
Advanced Features 
Direct

Select this object to enable access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object, When this 
option is selected, after a user clicks Preferences in the Print dialog box, 
the Printing Preferences dialog box is bypassed and instead, the 
Manufacturer’s Print dialog box for the selected printer opens 
immediately. The dialog box displays the advanced features that the 
manufacturer supports for the printer.

Disable All Select this option to disable access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object.

Printer Naming tab – Determines the format of the printer names that are to displayed to your 
users. You can set the printer naming scheme globally (the same print server naming scheme is 
applied to all the print server printers), or you can assign the naming scheme on a per printer basis. 
See “To set the printer naming scheme” on page 88.

Bandwidth Control tab - If the Simplify Print Server object is connected over a congested network, 
then to limit the amount of print data that is sent per minute, you can configure the bandwidth for the 
server on this tab. Note that limiting bandwidth for the print server might reduce the printing 
throughput for the server. 

Print Server Proxy tab - If you are using a Tricerat Print Server proxy, then enter the internal proxy 
address and the proxy group name on this tab.

Information tab – Read-only tab that displays information about the server on which the print 
server is hosted such as the OS version, the default language information, and so on.

Table 2-1: Print Server Object form (Continued)

Option Description
Simplify Suite Administrator Guide 81



Chapter 2
Managing Printer Objects in Simplify Printing
3. If you are not using a Tricerat Print Server proxy, then go to Step 4; otherwise, 

a. Open the Print Server Proxy tab.
b. Make sure that Use a proxy for print server is selected. 
c. Enter the internal proxy address and the proxy group name.

d. Go to Step 4.

Figure 2-2:  Simplify Console with new Print Server object entry, Print Server Proxy tab

4. Enter the name for the new Print Server object.

A Simplify Console message opens, asking you to confirm the changes made to the 
object’s settings. 

Figure 2-3:  Simplify Console message

5. Click Yes to close the message.

6. Click Test Connection to verify the Simplify Print Server communication.

If the connection is successful, then a Simplify Console message opens, indicating this. 
See Figure 2-4 on page 83.

Tricerat recommends that you use the print server hostname for the object name.

If the connection is not successful, then a Simplify Console error message opens 
instead. Resolve the issues that resulted in the error, and repeat this step as 
needed until the Test Connection successful message is displayed.
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Figure 2-4:  Simplify Console Test Connection successful message

7. Click OK to close the message.

8. Click Import New Printers.

A Simplify Console message that lists all the printers that will be imported for the Print 
Server object opens. 

Figure 2-5:  Simplify Console Import Printers message

9. Click OK to close the message and start the importing of the printers.

A Querying Printers message opens. The message displays the progress of gathering 
the data for each printer that is to be imported, and then importing the printer. 

Figure 2-6:  Querying Printers message
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After all the data for all the printers is gathered, the Object pane is automatically 
populated with an entry for each imported printer. After a printer is successfully imported, 
you can click on the printer entry and configure its Advanced Print Features (APF) 
Settings, or to configure all the imported printers with the same APF settings, you can do 
so at the Simplify Print Server object level. See Figure 2-7 and Figure 2-8 below.

Figure 2-7:  Imported printers with APF Settings

Figure 2-8:  Imported printers with APF Settings at Print Server object level

10. Continue to “To assign the print server printers” on page 85.

Be patient during the import process as it can take a while depending on the 
number of printers that are being imported. The Simplify Console is unavailable 
during this time. You must wait for the query to complete for the print server.
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To assign the print server printers
After you have added the print server object and imported the associated printers, the next 
step is to assign the print server printers to the correct owners. You can assign the printer 
server printers in one of two ways:

• You can directly assign the printer. See “To directly assign a print server printer to an 
owner” below.

• You can dynamically assign the printer. See “To create an owner for a printer assignment 
(Proximity Printing)” on page 87.

To directly assign a print server printer to an owner
You can directly assign a print server printer to an owner in one of the three locations in the 
Assignments pane:

• Admin Assigned – Any print server printer that you assign to an owner as Admin Assigned 
is always built for the owner. The owner does not have the option of whether to build the 
printer, nor does the owner have the option of removing the printer from a Simplify Printing 
session. You should add print server printers to the Admin Assigned location to prevent 
an owner from being able to affect the building of specific printers. An owner always has 
the option of setting any Admin Assigned printer as the default printer for a session 
through the User Assigned Printers (UAP) application.

• User Allowed – If you assign a print server printer to an owner as User Allowed, then the 
owner can use the UAP application to add this printer to the list of printers that are to be 
built for the current Simplify Printing session. The owner can always delete and re-add 
the printer as needed.

• User Assigned – If you assign a print server printer to an owner as User Assigned, then 
this printer is automatically built during the owner’s Simplify Printing sessions. If the owner 
does not want the printer to be built during Simplify Printing sessions, then the owner can 
use the UAP application to delete the assignment. The printer is no longer built for the 
owner’s Simplify Printing sessions and the owner cannot add this printer back to the list 
of printers that are to be built for a session.

Figure 2-9:  Assignment locations for a print server printer

For detailed information about the UAP application, see the Simplify User 
Assigned Printers Tool Quick Reference Guide.
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1. In the Owners pane in Simplify Console, select the owner (user or group) to which you 
are assigning the Print Server printer.

The selected owner is displayed at the top of the Assignment hierarchy in the 
Assignments pane.

2. In the Assignments pane, do the following:

• To show Admin Assigned, expand Printers > ScrewDrivers > <Version Number> 
Print Server Printers.

• To show User Allowed and User Assigned, expand Printers > ScrewDrivers > 
<Version Number> Print Server Printers > User.

3. For each Print Server Printer that is to be assigned to the selected owner, do the 
following: From the Objects pane, drag the appropriate Print Server printer to one of the 
three assignment folders: Admin Assigned, User Allowed, or User Assigned.

Figure 2-10: Assigned Print Server Printers in Simplify Console

You must repeat the following procedure in its entirety for each owner to which you 
are assigning Print Server printers.

If the needed owner is not available in your Active Directory, then you can always 
create it. See “To create an owner for a printer assignment (Proximity Printing)” on 
page 87.

w

If you assign any User Allowed printers to an owner, then either you or the owner 
must log in to the Simplify User Assigned Printers Tool and build the printers. See 
the Simplify User Assigned Printers Tool Quick Reference Guide for assistance.
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To create an owner for a printer assignment (Proximity Printing)
Simplify Printing provides the option of proximity printing, which allows for printers to be 
dynamically assigned to owners based on either the hostnames, IP addresses, or range of 
IP addresses for the clients that the owners are using to connect to Simplify Printing. This 
option is particularly useful if your organization has many locations and you want to create a 
group to organize the various hostnames and/or IP addresses. You can also organize the 
groups by something that better suits your working needs such as building, location, country, 
and so on, rather than directly referencing hostnames or IP addresses.

1. In the Owners pane, scroll to the Computers entry. 

Figure 2-11: Computers entry in the Owners pane in the Simplify Console

2. Right-click the Computers entry, and on the context menu that opens, select Add, and 
then select one of the following options to create the owner:

Option Description
Group An organizational grouping of one or more groups, computers, IP 

addresses, and/or IP address ranges. After you name the group, you 
must add owners to the group. To add owners, 
right-click the group name, and on the context menu that opens, select 
one of the following as appropriate:
• Add | Computer (See “Computer” below.)
• Add | IP Address (See “IP Address” below.)
• Add | IP Address Range (See “IP Address Range” on page 88.)
You can nest groups within other groups.

Computer The complete device name for the client machine from which the 
owner is connecting to Simplify Printing, and not the fully qualified 
domain name. After you enter the device name, you can make 
assignments to the device in the same manner that you make 
assignments to a group, a user, and so on. You can use wildcard 
characters in the device name, including a question mark (?) to specify 
a single character and an asterisk (*) to specify multiple characters.

IP Address The IP address for the client machine from which the owner is 
connecting to Simplify Printing. This is a single IP address.
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3. Assign the print server printers accordingly, and then continue to “To configure the print 
server printers” below.

To configure the print server printers
After you have assigned the print server printers to their correct owners, then you must 
configure the print server printers. Configuring print server printers consists of setting the 
naming scheme for the printers, which determines how the printers are named on the server 
and also specifying which print server printer is to be the default printer for an owner. You 
can also enable or disable access to the advanced features for a print server printer. When 
you configure the naming scheme for the print server printers, you can set the naming 
scheme globally (the same print server naming scheme is applied to all printers on the print 
server, which is the default value), or you can set the naming scheme on a per printer basis. 
After you specify a particular printer to be the default printer for an owner, the owner can 
always override this assignment in the UAP application and select a different printer to be the 
default printer.

To set the printer naming scheme
1. Do one of the following:

• To configure a global naming scheme for your printer server printers, in the Objects 
pane, select the appropriate print server. 

• To configure the printer naming scheme on a per printer basis, in the Objects pane, 
select the appropriate print server printer.

The corresponding object form is displayed in the right sub-pane. 

2. Click the Printer Naming tab to open it.

The tab displays all the options that are available for specifying the printer naming 
scheme. If the tab is opened for a print server printer, than an additional option, (1) Use 
Print Server’s Naming Scheme, is displayed at the top of the tab, and by default, it is 
selected. See Figure 2-12 on page 89.

IP Address Range The range of IP addresses for the client machines from which the 
owners are connecting to Simplify Printing. This is the low IP address 
and the high IP address of the appropriate range.

To review how to assign objects to an owner, see “Managing Assignments” on 
page 53.

Option Description

For detailed information about assignment locations for print server printers, see 
“To assign the print server printers” on page 85.
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Figure 2-12: Print Server Printer Object Form, Printer Naming tab

3. Do one of the following:

• If you are configuring a global naming scheme for your print server printers, then 
configure the scheme on the Printer Naming tab on the print server object form. By 
default, the naming scheme is set to Printer Name (MACHINE:SESSION). Go to 
Step 4.

• If you are configuring the printer naming scheme on a per printer basis, then for the 
print server printer, clear the option Use Print Server’s Naming Scheme at the top of 
the Printer Naming tab, and then continue to configure the scheme on the tab. Go to 
Step 4.

You can set a per printer naming scheme for every print server printer in your 
Simplify Suite environment, or for just selected printers. If you do not clear the 
option Use Print Server’s Naming Scheme at the top of the Printer Naming tab for 
a print server printer, then the print server’s naming scheme is used for the printer.

1
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4. Do one of the following:

• Select one of the four default schemes.

• Printer Name (MACHINE:SESSION)

• MACHINE:SESSION (Printer Name)
• Printer name (USER:SESSION)
• USER:SESSION (Printer Name)

• To set up a custom printer naming scheme, select Custom.

5. Do one of the following:

To define a custom printer naming scheme
1. Set the format of the scheme using Session ID and one or more of the following: Printer, 

Machine Name, and User. 

In addition to the Session ID, the name can have up to three components, but you can 
specify a single component (for example, Machine Name), two components (for 
example, Machine Name and Printer), or all three components (for example, Machine 
Name, Printer, and User).

2. Optionally, do any or all of the following as needed:

• Select “Limit name component lengths,” and then set the maximum value for any or 
all of the indicated components (Printer, Machine, and/or User.) The default value is 
ten.

Step Action
If you are implementing a default 
naming scheme as-is.

N/A. 

If you are implementing a default 
printer naming scheme, but you want 
to edit the scheme.

Do one or both of the following as appropriate:
• Select “Limit name component lengths,” and then set 

the maximum value for any or all of the indicated 
components (Printer, Machine, and/or User.) The 
default value is ten.

• Select which options in the printer name are to be 
replaced, and then leave a default replacement value 
as-is, or modify it as needed. For example, if you 
select “Replace backslashes (\) in the printer name 
with _, then, by default, an underscore replaces every 
backslash in the printer name. You can leave the 
underscore as-is, or you change it to another value 
such as an asterisk (*).

If you are implementing a custom 
printer naming scheme.

Continue to “To define a custom printer naming scheme” 
on page 90.

Tricerat does not support a format without a Session ID. A user could log in to 
multiple sessions, which can result in a naming conflict.
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• Select which options in the printer name are to be replaced, and then leave a default 
replacement value as-is, or modify it as needed. For example, if you select “Replace 
backslashes (\) in the printer name with _, then, by default, an underscore replaces 
every backslash in the printer name. You can leave the underscore as-is, or you 
change it to another value such as an asterisk (*).

To set a default printer for an owner
You can set a single Admin Assigned print server printer or a single User Assigned print 
server printer to be the default printer for an owner. (Because an owner always has the 
option of whether to build a User Allowed print server printer, you cannot specify any User 
Allowed print server printer to be the default printer.) After you set the default printer for an 
owner, the owner can always override this assignment in the UAP application and set a 
different printer as the default. To set a default printer for an owner, do the following:

1. In the Owners pane in Simplify Console, select the owner (user or group) for which you 
are setting the default printer.

The selected owner is displayed at the top of the Assignment hierarchy in the 
Assignments pane.

2. In the Assignments pane, do the following:

• To show all Admin Assigned print server printers, expand Printers > ScrewDrivers > 
v6 Print Server Printers > Admin Assigned.

• To show all User Assigned print server printers, expand Printers > ScrewDrivers > v6 
Print Server Printers > User > Assigned.

3. Right-click any single Admin Assigned or User Assigned print server printer, and on the 
context menu that opens, click Set as Default.

The selected printer is marked with a blue checkmark in the Assignments pane. 

Figure 2-13: Default print server printer set for an owner
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To enable/disable access to the advanced features for a print 
server printer
Simplify Printing supports advanced features that are uniquely defined by each printer 
manufacturer such as secure printing, stapling, and so on. This function is made possible by 
providing access for the user to the manufacturer’s Print dialog box during the user’s session 
while still using the ScrewDrivers virtual print driver on the Terminal Server, Virtual Desktop, 
or workstation. You can enable access to the advanced features at the global level, (the 
same level of access is applied to all printers on the print server), which is the default value, 
or you can enable access on a per printer basis.

To enable/disable access to the advanced features at the global level 
1. In the Objects pane, select the appropriate print server object.

The object form for the print server is displayed in the right sub-pane. The General tab is 
the open tab.

Figure 2-14: Imported printers with APF Settings at Print Server object level

2. Under Tricerat Advanced Print Features, select the appropriate option:

Table 2-2: Tricerat Advanced Print Features, selected at the Simplify Print Server object 
level

Option Description
Default to Not Use 
Advanced Print 
Features

Selected by default. Disables access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object. For access to 
the advanced features for all the printers to the Simplify Print Server object, 
one of two options must be selected:
• “Default to Use Advanced Features Indirect.”
• “Default to Use Advanced Features Direct.”
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To enable/disable access to the advanced printer features on a per printer 
basis
1. In the Objects pane, select the appropriate print server printer.

Figure 2-15: Imported printers with APF Settings

2. Under Tricerat Advanced Print Features, select the appropriate option:

Default to Use 
Advanced Features 
Indirect

Select this object to enable access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object, When this option 
is selected, after a user clicks Preferences in the Print dialog box, the Printing 
Preferences dialog box opens with an Advanced Print Features tab. The user 
then must open the Advanced Print Features tab, and click Show UI to open 
the Advanced Print Features dialog box for the selected printer. The dialog 
box displays the advanced features that the manufacturer supports for the 
printer.

Default to Use 
Advanced Features 
Direct

Select this object to enable access to the advanced features for all the 
printers that are assigned to the Simplify Print Server object, When this option 
is selected, after a user clicks Preferences in the Print dialog box, the Printing 
Preferences dialog box is bypassed and instead, the Advanced Print 
Features dialog box for the selected printer opens immediately. The dialog 
box displays the advanced features that the manufacturer supports for the 
printer.

Table 2-3: Tricerat Advanced Print Features, selected at the Simplify Print Server object 
level 

Option Description
Use Print Server Default Access is determined by the AFP setting that has been specified for the 

Simplify Print Server object to which the printer is assigned.

Table 2-2: Tricerat Advanced Print Features, selected at the Simplify Print Server object 
level

Option Description
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Do Not Use Advanced 
Print Features

Select this option to disable access to the advanced features for the 
selected printer. For access to the advanced features for the printer, one 
of two options must be selected:
• “Default to Use Advanced Features Indirect.”
• “Default to Use Advanced Features Direct.”

Default to Use 
Advanced Features 
Indirect

Select this object to enable access to the advanced features for the 
selected printer. When this option is selected, after a user clicks 
Preferences in the Print dialog box, the Printing Preferences dialog box 
opens with an Advanced Print Features tab. The user then must open 
the Advanced Print Features tab, and click Show UI to open the 
Manufacturer’s Print dialog box for the selected printer. The dialog box 
displays the advanced features that the manufacturer supports for the 
printer.

Default to Use 
Advanced Features 
Direct

Select this object to enable access to the advanced features for the 
selected printer. When this option is selected, after a user clicks 
Preferences in the Print dialog box, the Printing Preferences dialog box 
is bypassed and instead, the Manufacturer’s Print dialog box for the 
selected printer opens immediately. The dialog box displays the 
advanced features that the manufacturer supports for the printer.

Table 2-3: Tricerat Advanced Print Features, selected at the Simplify Print Server object 
level (Continued)

Option Description
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Viewing Print Server Print Jobs
Information about a print job is automatically generated any time a print job is routed through 
a print server printer. If your Simplify Suite installation included Print Job Viewer, then you 
can view this information for any print job that any owner has sent to a print server printer in 
your Simplify Suite environment. For additional filtering capabilities, you can export this print 
job information to a comma-separated values (.csv) file.

To view print server print jobs
If your Simplify Suite installation included the Print Job Reporting, then a shortcut icon for the 
Print Job Reporting is placed on your desktop. An option for Print Job Reporting is also 
available from your Start menu. 

1. Do one of the following to open Print Job Viewer: 

• Double-click the Print Job Viewer desktop icon.

Figure 2-16: Print Job Viewer desktop shortcut

• Select the option from your Start menu (Start > All Programs > Tricerat > Print Job 
Viewer).

2. Click Load Data. 

The Print Job Viewer is refreshed with the information for all the print jobs that all owners 
in your Simplify Suite environment have sent to any print server printer.

Figure 2-17: Print Job Viewer

To view print server jobs, the Print Server Reporting feature must be installed on 
at least one of your Simplify Printing print servers. For details about installing and 
configuring this feature, see the Simplify Printing Quick Start Guide.
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3. Optionally, do any or all of the following as needed:

• To sort the displayed print jobs by a specific characteristic, for example, the 
Document Name, click the appropriate column header.

• To filter the data to only specific print server print jobs, enter standard search syntax 
for Microsoft SQL Server in the Filter field, and then click Apply Filter.

• To export the data to a comma-separated values (.csv) file, click Export. By default, 
the file is named Print Job Report, and it is saved in your My Documents directory, 
but you can change one or both of these values. If you want to filter by other means, 
including a Pivot table, you can now export this file to a third-party spreadsheet 
application such as Microsoft Excel.

For information about standard search syntax for Microsoft SQL Server, see 
https://msdn.microsoft.com/en-us/library 
system.data.datacolumn.expression(v=vs.110).aspx.
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Setting Up a Failover Print Server
The Simplify Console provides an option for you to set up a failover print server for any of 
your primary print servers. The failover printer server is a true failover server - it is not a load 
balancer. To set up a failover print server, you must first set up at least two identical print 
servers, for example, qa-srv005. and qa-srv006. These multiple identical print servers must 
have the same print queues, the same queue names, the same print drivers, and so on. One 
of these identical print servers is designated as the primary print server for your users, for 
example, qa-srv005. You would then assign the printers for qa-srv005 to your users and you 
would assign qa-srv006 to the list of available Failover Print Servers. As a result, if there is 
any failure to communicate with any printer that is assigned to  
qa-srv005, then the list of available Failover Print Servers is queried in the order that the print 
servers are displayed until one of the following happens:

• A failover print server is queried successfully and the print job is completed from this print 
server.

• No failover print servers are queried successfully (the list of available print servers is failed 
all the way through) and the print job is not completed.

For example, as shown in Figure 2-18 below, if there is any failure to communicate with any 
printer that is assigned to qa-srv005, then the list of available Failover Print Servers is 
queried in the order that the print servers are displayed (qa-srv006, qa-srv007, and then qa-
srv008) until a print job can be completed successfully from any of these failover print 
servers or the job is failed all the way through.

Figure 2-18: Failover Print Servers
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To set up a failover print server
1. Add, assign, and configure the necessary primary print server printers for your users. 

See “Managing Print Server Printers” on page 79.

2. In the Objects pane, select the primary print server object.

The object form for the print server object is displayed in the right sub-pane. The General 
tab is the open tab.

Figure 2-19: Failover Print Servers

3. For each failover print server printer that is to be assigned to the selected primary print 
server, do the following:

a. In the Failover Print Servers pane, click the Add Print Server icon .

The entry “New Failover Print Server” is displayed in the Failover Print Servers list, 
and it is automatically highlighted.

Figure 2-20: New Failover Print Server entry

The failover print servers must have the same print queues, the same queue 
names, the same print drivers, and so on as the primary print servers. 
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b. Click in the highlighted entry, and then enter the name for the failover print server.

c. With the newly added failover print server still selected in the Failover Print Servers 

list, click the Connect Print Server icon .

A Simplify Console message opens, indicating that the connection to the failover 
print server was successful.

Figure 2-21: Connection Successful message

d. Click OK.

The message closes and the failover print server is now connected and active for 
the selected primary print server.

After you add one or more failover print servers, additional icons are enabled for the Failover 
Print Servers list. You use the Up and Down icons to change the order of the failover print 
servers in the list, and therefore, the order in which the servers are queried after the failure of 
the primary print server. You use the Delete icon to delete a selected failover print server.

Figure 2-22: Failover Print Servers list with enabled icons

If you delete a failover print server, the print server is removed immediately from 
the network. Any jobs that were in progress before the print server was deleted 
are completed. Any jobs that were still in a printer’s queue at the time the print 
server was deleted cannot be completed. 

Item Description
1 Use to rearrange the order of the failover print servers in the list, and therefore, the 

order in which the servers are queried after the failure of the primary print server.

2 Delete a selected failover print server.

1

2
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You can assign ScrewDrivers-specific configuration settings to an owner in the Simplify 
Console. <Version Number> PDF-Only Settings, for example, v6 PDF-Only Settings, are 
configuration settings for printer objects that support PDF generation. When you assign 
PDF-Only Settings to an owner, a printer that uses the ScrewDrivers PDF print driver is 
automatically generated. The owner can then create and print PDFs from any application 
that supports PDF generation. Default ScrewDrivers configuration settings contain printer 
creation options that determine the client printers that are built on the Simplify Suite server 
when a user logs in. Extended settings options that allow for further customizations of your 
users printing environments, such as specifying the default printer and when to delete 
printers from sessions, are also available. This chapter details the ScrewDrivers 
configuration settings that are available for assignment in the Simplify Console.

This chapter covers the following topics:

• “Assigning PDF-Only Settings to an Owner” on page 101.

• “Assigning Default ScrewDrivers Settings to an Owner” on page 103.
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Assigning PDF-Only Settings to an Owner
PDF stands for Portable Document Format, which is a lightweight universal document 
exchange format. Almost all modern operating systems support PDF viewing and printing, 
including, but not limited to, Windows, Max, Linux, and UNIX. PDF-Only Settings are 
configuration settings for printer objects that support PDF generation. When you assign 
PDF-Only Settings to an owner, a printer that uses the ScrewDrivers PDF print driver is 
automatically generated. The owner can then create and print PDFs from any application 
that supports PDF generation. After you assign a PDF printer to an owner, optionally, you 
can configure the settings for exporting the PDF file to the server. If you select a setting for 
configuration, then you must specify the category for the setting:

• Deny - Prevents the owner from enabling the administrator-denied setting and changing 
the default value for the setting. The function is completely prohibited during the printing 
process.

• Force - Prevents the user from changing the administrator-defined value for the setting. 
If a setting is selected and set to Force, then the associated function is completely 
automated during the printing process.

• Suggest - As the Simplify Suite administrator, you can define a default value for the 
setting, but an owner can always override this value at the time of printing. If the owner 
leaves the default value as-is for a setting, then the associated function is completely 
automated during the printing process; otherwise, if the owner decides to override the 
default value for a suggested setting, then the owner must do so by accessing the Printing 
Preferences dialog box for the printer during the session.

You can leave the printer naming scheme for a PDF printer set to the default value of Printer 
Name (MACHINE:SESSION), or optionally, you can modify the scheme.

To assign and configure PDF-only settings to an owner
1. In the Objects pane, under ScrewDrivers > <Version Number> PDF-Only Settings, 

create a new PDF printer object.

The printer object form is displayed in the right sub-pane. The General tab is the open 
tab.

Figure 3-1:  PDF printer object form

To review how to add objects in the Simplify Console, see “Managing Objects” on 
page 47.
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2. In the Owners pane in Simplify Console, select the owner (user or group) to which you 
are assigning the settings.

The selected owner is displayed at the top of the Assignment hierarchy in the 
Assignments pane.

3. Assign the PDF printer object to the selected owner.

4. Optionally, on the General tab of the PDF printer object form, select the printer settings 
that you want to configure, and specify Deny, Force, or Suggest as appropriate. If you 
specify Force or Suggest for a setting, then you must also provide a default value for the 
setting.

5. Leave the printer naming scheme set to the default value of Printer Name 
(MACHINE:SESSION), or optionally, modify the printer naming scheme. See Step 4 of 
“To set the printer naming scheme” on page 88.

To review how to assign objects to an owner, see “Managing Assignments” on 
page 53.

If you do not select any settings for configuration, then the Save dialog box opens 
for setting the printing preferences.

Setting Description
Save Mode Select one of two allowed values:

• Display Save Dialog – Select this value if the owner is save the PDF 
to an owner-specified location.

• Use Input Pathname — Select this value if the owner is to save the 
PDF to a pre-defined location.

Destination If Save Mode is set to Use Input Pathname, then you must specify the 
pre-defined location here. 
Tip: Click Help to open a dialog box that displays the variables that, in 

addition to Windows variables, are supported in a path name.

If File Exists If Save Mode is set to Use Input Pathname and the pre-defined location 
exists, then select one of four allowed values:
• Overwrite: Automatically overwrite the existing file on the Print Server 

with the new file.
• Prompt: Prompt the user to overwrite the existing file on the Print 

Server, or take other actions.
• Cancel: Cancel the saving of the file. The existing file on the Print 

Server remains unchanged and no new file is saved.
• Append: Add the new file to the end of the existing file on the Print 

Server. A single file is produced that contains both the existing (old) 
content and the new content.
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Assigning Default ScrewDrivers Settings to an 
Owner

You configure the Default ScrewDrivers Settings on the General tab of the object form. The 
default settings include printer creation options that determine the client printers that are built 
on the Simplify Suite server when a user logs in as well as extended settings options that 
allow for further customizing of your users’ printing environments, such as specifying the 
default printer and when to delete printers from sessions.

To assign and configure the default ScrewDrivers settings
1. In the Objects pane, under ScrewDrivers > <Version Number> Settings (for example, v6 

Settings), select Default ScrewDrivers Settings.

The the Default ScrewDrivers Settings object form is displayed in the right sub-pane. 
The General tab is the open tab.

Figure 3-2:  Default ScrewDrivers Settings object form, General tab

2. Configure the Default ScrewDrivers Settings.

Option Description
Printer Creation - Determine which of the user’s printers are built on the Simplify Suite server after 
the user logs in. You can select only one Printer Creation option at a time.

Do not add any client 
printers

If enabled, none of the client’s printers are added to the Simplify Suite 
server after a user logs in. 
Note: You typically enable this option only when Tricerat Support 

instructs you to do so. 

Add all client printers If enabled, all the client’s printers are added to the Simplify Suite server 
after a user logs in. 

Add only the client’s 
default printer

Selected by default. If enabled, only the client’s default printer is added 
to the Simplify Suite server after a user logs in.
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3. In the Owners pane in Simplify Console, select the owner (user or group) to which you 
are assigning the settings.

The selected owner is displayed at the top of the Assignment hierarchy in the 
Assignments pane.

4. Assign the Default ScrewDrivers Settings to the selected owner.

Add clients first 0 
printers

Always add client’s 
default

Change the default value of 2 as needed. The first “n” number of printers 
that are displayed in the list of available printers for the ScrewDrivers 
client are then added to the Simplify Suite server after a user logs in with 
the following caveat:
• If Always add client’s default is selected, and the client’s default 

printer is not included in the first “n” of printers that are displayed in 
the available list, then first the “n-1” number of printers that are 
displayed in the list of available printers are added as is the client’s 
default printer.

Extended Settings - Provide additional printing features that can be useful depending on your 
users’ environments.

Allow default printer 
spoofing

If enabled, then a user can specify a printer that is not defined as the 
default printer on the ScrewDrivers client to be the default printer on the 
Simplify Suite server for a terminal session. 
Note: This option is applicable for situations in which a user can work 

locally or through a terminal session, but requires a different 
default printer in each case.

Recapture the default 
printer after 30 seconds

If enabled, then the default printer for the ScrewDrivers client is set 
again on the Simplify Suite server after the specified time period. This 
prevents the traditional “server printers” from being set as the user’s 
default printers during a terminal session. You can change the default 
value of 30 seconds as needed.

Delete printers on 
session disconnect, and 
add on reconnect

If enabled, then when a terminal session is disconnected, or a user logs 
off, all the client printers are removed from the Simplify Suite server. 
When the terminal session is reconnected, or a user logs back in, all the 
client printers are then built again on the server.

To review how to assign objects to an owner, see “Managing Assignments” on 
page 53.

Option Description
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This appendix provides some general considerations when troubleshooting ScrewDrivers. It 
also provides information about solving some of the most common problems you might 
encounter when using ScrewDrivers.

This appendix covers the following topics:

• “General Troubleshooting Considerations” on page 106.

• “ScrewDrivers Server Troubleshooting” on page 107.

• “ScrewDrivers Client Troubleshooting” on page 110.
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General Troubleshooting Considerations
The most common issues that you encounter with ScrewDrivers are the following:

• Printers are not building for any user.

• Printers are not deleted after a user logs off a session.

• Output issues with fonts and/or graphics.

• Missing features.

• Slow server spooling.

• Users are seeing duplicate printers.

• Users are seeing other users’ printers.

• The default printer is not being assigned correctly, or assigned at all.

When you are troubleshooting ScrewDrivers, keep in mind the three key functional areas 
that are involved:

• The application from which the job is being printed.

• The ScrewDrivers Server and client.

• The client spooler and native print driver.

As is typical with any product, the recommended way to troubleshoot ScrewDrivers is to 
eliminate possible causes first, and then focus on the root cause. Generally, when 
troubleshooting ScrewDrivers, you should first determine whether the problem resides with 
the ScrewDrivers Server or the client. To do this, you can test ScrewDrivers with multiple 
clients. If the same negative results are associated with multiple clients, then more than 
likely, the problem resides on the server. After you have isolated the problem to the server or 
the client, your next step is to review the troubleshooting recommendations in this appendix. 
If you cannot resolve the issue using the recommendations in this appendix, then you must 
contact support@tricerat.com for additional assistance. 
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ScrewDrivers Server Troubleshooting
The following are high-level instructions for troubleshooting the ScrewDrivers Server. If you 
cannot resolve the issue with your ScrewDrivers Server based on these instructions, then 
contact support@tricerat.com for additional assistance. 

Printers are not building for any user

Typically, when printers build for a user’s session, they are displayed in the users’ Registry 
under HKLM\System\Current\ControlSet\Control\Print\Printers. Keeping in mind that a user 
sees only those printers for which permissions have been granted, the system location is 
equivalent to what is observed in the regular Printers folder in the Terminal or Remote 
Desktop session. If printers are not building for a user, then you must reinstall the print driver 
and the printer port.

1. Navigate to the following directory:C:\Windows\System32\spool\drivers\w32x86\3

2. Rename the following files with an extension of .old: sd6drv.dll and sd6ui.dll.

3. Reboot the print server.

4. Delete the two “old” files that you renamed in Step 2.

5. Navigate to the following directory: C:\Tricerat\ScrewDrivers Server v6.

6. Run the following executables in the order indicated:

• install_driver.exe (installs the print driver)

• install_port.exe (installs the printer port)

• setsec_server.exe (sets the security for the server components)

Your users should now be able to log in to new sessions and have their printers built.

Some printers are not deleted when the user logs off
You can clear the spool directory.

1. Open the Services dialog box: Control Panel > Administrative Tools > Services.

2. Stop the Windows Print Spooler service.

The following procedure should be carried out only if no users are logged in to the 
ScrewDrivers Server.

An error message that indicates that the ports have already been installed might 
open. You can ignore this message, and click OK to continue.

The following procedure should be carried out only if no users are logged in to the 
ScrewDrivers Server.
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3. In Windows\System32\Spool\Printers, delete all files.

4. Start the Windows Print Spooler service.

5. Under Printers and Faxes on the server, delete any printers that are not installed directly 
on the server.

Output issues with fonts and/or graphics
If fonts are not being formatted correctly and/or fonts and graphics are nor properly scaling, 
then two options are available:

• Upgrade the print driver on the ScrewDrivers client.

• Enable Print-As-Image.

Upgrade the print driver
You should first to attempt to resolve the issue by upgrading the print driver. 

1. Upgrade the local print driver to the latest version on the ScrewDrivers client, where PCL 
> PS.

2. Carry out a query on the ScrewDrivers client. 

3. Carry out a test print. 

If the issue is still not resolved, then your next option is to enable Print-As-Image on the 
server.

Enable Print-As-Image
You enable Print-As-Image either mid-session, or you can set Print-As-Image as the default 
for a client printer.

To enable Print-As-Image mid-session
1. In any application on the ScrewDrivers Server, click Print to open a Print dialog box.

2. In the list of available printers on the Print dialog box, select the correct ScrewDrivers 
printer, and then click Preference to open the Printing Preferences dialog box.

3. On the Printing Preferences dialog box, open the Extended Options tab.

4. On the Extended Options tab, select Sent print job as an image, and then set the DPI. 

5. Click OK.
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To set Print-As-Image as the default for a client printer
1. Open the ScrewDrivers Client Control Panel.

2. Open the Printers tab.

3. In the list of Available Printers, select the appropriate printer.

4. In the Extended Options - Print Job Rendering Options panel, enable Print-As-Image, 
and then set the DPI.

5. Click Apply.

Users are seeing duplicate printers
By default, auto-creation is turned on for Citrix (ICA protocol) or Terminal Services (RDP 
protocol). If auto-creation is enabled through Citrix or Terminal Services, then it is possible 
for users to see duplicate printers after the ScrewDrivers Server and client are installed. As a 
result, Tricerat recommends that you turn off auto-creation in your ScrewDrivers 
environment. This not only eliminates the appearance of duplicate printers, but it also 
mitigates the known issues that are associated with auto-creation such as print driver 
problems, output (font and graphics) problems, and so on.

Users are seeing not only their own printers but also other users’ 
printers

This problem is not associated with ScrewDrivers. Instead, it is a known third-party issue. 
Contact support@tricerat.com for assistance.
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ScrewDrivers Client Troubleshooting
The following are high-level instructions for troubleshooting the ScrewDrivers client. If you 
cannot resolve the issue with your ScrewDrivers client based on these instructions, then 
contact support@tricerat.comfor additional assistance. 

ScrewDrivers not building during a session
Generally, the two most common reasons for ScrewDrivers not building during a session are:

• Client updates

• Incompatible ScrewDrivers client version

Client updates
If the ICA or RDP client is updated, then the reference to the ScrewDrivers client is 
overwritten. To resolve this issue, run the appropriate executable on the ScrewDrivers client:

• For an ICA client: C:\Program Files\Tricerat\Simplify Printing\ScrewDrivers Client 
v6\install_ica.exe.

• For an RDP client: C:\Program Files\Tricerat\Simplify Printing\ScrewDrivers Client 
v6\install_rdp.exe.

Incompatible ScrewDrivers client version
The version of ScrewDrivers client that is currently installed on a workstation is displayed on 
the About tab of the ScrewDrivers Client Control Panel. (See “The ScrewDrivers Client 
Control Panel” on page 35.) If the ScrewDrivers client that is installed on a workstation is not 
the most current version, then you have two options:

• You can download the most recent version from the Tricerat website at  
http://www.tricerat.com/support-center/downloads/printing-clients, and manually update 
the client version.

• You can enable automatic client updates on the server side, and prevent the client from 
ever being out of date. See“Enable automatic client updates” in “The ScrewDrivers Server 
Control Panel, Advanced Tab” on page 29.

If neither of these options work, then the final troubleshooting step is to reinstall the 
ScrewDrivers client. To do so:

1. Uninstall the current ScrewDrivers client through Add/Remove Programs.

2. Restart the client workstation.

3. Install the latest version of the ScrewDrivers client.
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Output issues with fonts and/or graphics
If fonts are not being formatted correctly and/or fonts and graphics are nor properly scaling, 
then two options are available:

• Upgrade the print driver on the ScrewDrivers client.

• If allowed by the server, (Suggest) enable Print-As-Image.

Upgrade the print driver
You should first to attempt to resolve the issue by upgrading the print driver. 

1. Upgrade the local print driver to the latest version on the ScrewDrivers client, where PCL 
> PS.

2. Carry out a query on the ScrewDrivers client. 

3. Carry out a test print. 

If the issue is still not resolved, then your next option is to enable Print-As-Image on the 
server.

Enable Print-As-Image
You enable Print-As-Image either mid-session, or you can set Print-As-Image as the default 
for a client printer.

To enable Print-As-Image mid-session
1. In any application on the ScrewDrivers client, click Print to open a Print dialog box.

2. In the list of available printers on the Print dialog box, select the correct ScrewDrivers 
printer, and then click Preference to open the Printing Preferences dialog box.

3. On the Printing Preferences dialog box, open the Extended Options tab.

4. On the Extended Options tab, select Sent print job as an image, and then set the DPI. 

5. Click OK.

To set Print-As-Image as the default for a client printer
1. Open the ScrewDrivers Client Control Panel.

2. Open the Printers tab.

3. In the list of Available Printers, select the appropriate printer.

4. In the Extended Options - Print Job Rendering Options panel, enable Print-As-Image, 
and then set the DPI.

5. Click Apply.

If needed, you can also set Print-As-Image is to Force on the ScrewDrivers Server 
and this option then is applied to all client printers in a single step. 
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Default printer not being set correctly for one or more users
Window printer information is stored in the HKEY_CURRENT_USER hive. If a user logs in to 
ScrewDrivers with the same username from multiple different locations, then all these logins 
modify the HKEY_CURRENT_USER hive. Because there can be only one default printer, 
the printers do not get assigned correctly for any session other than the most recent session. 
To resolve this issue, you should first disable Window printer mapping. If the problem still 
persists, and multiple users are having this issue, then verify whether these multiple users 
are using the same username to log in to the same ScrewDrivers environment. If they are 
not using the same username, then verify whether each user is logging in to different client 
computers with the same username while remaining logged in to the original session.
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